
User’s
Manual

Yokogawa Electric Corporation

Model 761922
Harmonic Analysis Software
for the WT1600/WT2000

IM 761922-01E
2nd Edition



iIM  761922-01E

Disk No. BA47

2nd Edition : June 2003 (YK)

All Rights Reserved, Copyright © 2003 Yokogawa Electric Corporation

Foreword
Thank you for purchasing the Harmonic Analysis Software (Model 761922).

This user’s manual lists precautions that must be taken during use, and contains useful
information about the functions, and operating procedures of the software.  To ensure
correct use, please read this manual thoroughly before beginning operation.  After

reading the manual, keep it in a convenient location for quick reference whenever a
question arises during operation.  For information about the handling precautions,
functions, and operating procedures of the WT1600 Digital Power Meter (model 760101),

WT2000 series digital power meters (the WT2010 model 253101, and the WT2030
models 253102 and 253103) and the handling and operating procedures for Windows,
see the manuals for those products.

Notes
• The contents of this manual are subject to change without prior notice as a result of

continuing improvements to the instrument’s performance and functions.  The figures
given in this manual may differ from those that actually appear on your screen.

• Every effort has been made in the preparation of this manual to ensure the accuracy

of its contents.  However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing all or any part of the contents of this manual without the

permission of Yokogawa Electric Corporation is strictly prohibited.
• This software supports the WT1600 Digital Power Meter's firmware (ROM) version

2.07 or later.

• This software supports the WT2000 Digital Power Meter's firmware (ROM) version
1.41 or later.

• The TCP/IP software of this product and the document concerning the TCP/IP

software have been developed/created by YOKOGAWA based on the BSD
Networking Software, Release 1 that has been licensed from California University.

Trademarks
• Microsoft, Windows, Windows NT, Windows Me, and Windows XP are either

registered trademarks or trademarks of Microsoft Corporation in the United States

and/or other countries.
• Adobe and Acrobat are trademarks of Adobe Systems Incorporated.
• Other company and product names are trademarks or registered trademarks of their

respective companies.
• For purposes of this manual, the TM and  symbols do not accompany their

respective trademark names or registered trademark names.

Revisions
• 1st Edition January 2003

• 2nd Edition June 2003
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the
“Yokogawa Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing  the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached.  Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa
or those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT
TO YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee  on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.
Licensed Software Name: Harmonic Analysis Software Model 761922
Number of License: 1

Article 1 (Scope Covered by these Terms and Conditions)
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the

Licensee consents to agree to the terms and conditions stipulated herein.
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary

technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the

license fee separately agreed upon by both parties.
2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the

Licensed Software.
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall

secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee

may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software.  Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights.  In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for

the purpose of the following events:
a) Operation of any aviation, vessel, or support of those operations from the ground;,
b) Operation of nuclear products and/or facilities;,
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such

as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility
within seven (7) days after opening the Package at the Licensee’s expense.  As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.
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4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.

Article 5 (Infringement)
5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party.  Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa’s defense and negotiation.  If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa’s cost and expense.
a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use

the Licensed Software;
b) To replace the Licensed Software with an alternative one which avoids the infringement; or
c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee.  THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided

to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement.  However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement.  However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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Chapter 1 Product Overview

1.1 Explanation of Functions

This software application (761922) measures harmonic currents of electrical equipment
according to an applicable IEC standard, (see section 1.3 for an overview) and displays/
saves the results of evaluations made according to the standard.

Applicable Measurement Instruments
This software can be used with Yokogawa's WT1600 Digital Power Meter (model

760101) and three of the WT2000 series of digital power meters (the WT2010 model
25301, or the WT2030 models 253102 and 253103).  For information about the handling
precautions, functions, and operating procedures of the WT1600 or WT2000 series

digital power meters, see the manuals that came with those instruments.

Product User’s Manual Name User’s Manual No.

WT1600 WT600 Digital Power Meter IM760101-01E
(760101)

WT2010 WT2010 Digital Power Meter IM253101-01E
(253101)

WT2030 WT2030 Digital Power Meter IM253102-01E
(253102)
(253103)

Applicable Standard
The applicable standard of this software application is IEC 61000-3-2 (Electromagnetic
compatibility (EMC) - Part 3-2: Limits - Limits for harmonic current emissions (equipment

input current ≤ 16 A per phase)) Edition 2:2000 consolidated with amendment 1:2001,
abbreviated as IEC 61000-3-2 Edition 2.1, and EN61000-3-2 Amendment 14.  For an
overview of the standard, see section 1.3.

Retrieving and Loading of Measured Data/Waveform Data to Be Evaluated
Setting WT Measurement Conditions

This software application can be used to enter the same harmonic measurement
conditions that you can enter using the front panel keys of the WT.

Retrieving Measured Data from the WT Connected On-Line (On-Line Mode)
The measured data to be evaluated against the standard can be retrieved into your
PC via the GP-IB or Ethernet (WT1600 only) interface while making harmonic

measurements on the WT.

Loading Measured Data Already Saved (Off-Line Mode)
The measured data retrieved by the software can be saved.  The saved measured
data/waveform data can be loaded to be evaluated against the standard.
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Measurement Modes
Three measurement modes are available.  The type of data retrieved and the operation

vary depending on the measurement mode.
Harmonic Measurement Mode

• When in On-Line Mode
Measurement and evaluation of harmonics conforming to IEC 61000-3-2 Edition
2.1 can be made while making harmonic measurements on the WT.

16 cycles at the
fundamental frequency

16 cycles at the
fundamental frequency

Measures the harmonics Measures the harmonics

Retrieves the measured data
on the PC and stores them as
instantaneous values

Retrieves the measured data
on the PC and stores them as the
next set of instantaneous values

Measures the harmonics 
using the measurement 
conditions entered according 
to the applicable standard

Measurement time

One set of harmonic measurement data (handled as instantaneous values by the
software) consists of 16 cycles of measured data of the harmonic signal.  The

instantaneous values, the mean value, and the maximum value of the measured
data retrieved within the measurement time (see next page) can be evaluated to
determine whether they are within the limits of the standard.

• When in Off-Line Mode
Evaluation can be made on the loaded measurement data according to the method

complying with IEC 61000-3-2 Edition 2.1.

Harmonic Monitor Mode
This mode can be selected only when in On-Line mode.  Harmonic fluctuation can be
monitored on bar graphs and a numerical list while making harmonic measurements
on the WT.  This mode is used to monitor the conditions of the harmonics and does

not evaluate against the standard as in Harmonic Measurement Mode.  When the
next measured data is retrieved, the previous measured data is updated and does not
remain.

16 cycles at the
fundamental frequency

16 cycles at the
fundamental frequency

Measures the
harmonics

Measures the
harmonics

Measures the harmonics 
using the measurement 
conditions entered 
according to the 
applicable standard

Retrieves the measured data 
on the PC and displays a bar 
graph or numerical list

Retrieves the measured data 
on the PC and displays a bar 
graph or numerical list

The previous measured data is 
updated and does not remain.

1.1  Functional Explanation
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1Waveform Monitor Mode
This mode can be selected only when in On-Line mode.  The measured waveform

can be monitored while making harmonic measurements on the WT.  This mode is
used to monitor the conditions of the waveform and does not evaluate against the
standard as in Harmonic Measurement Mode.  When the next waveform data is

retrieved, the previous waveform data is updated and does not remain.

Approx. 2 cycles at the
fundamental frequency

Samples the
waveform data

Approx. 2 cycles at the
fundamental frequency

Samples the
waveform data

Retrieves the waveform 
data on the PC and 
displays the waveform

Retrieves the waveform 
data on the PC and 
displays the waveform

The previous waveform data is 
updated and does not remain.

Setting the Standard and Measurement Environment
Sets the classification of the equipment under test (EUT) as defined in IEC 61000-3-2
Edition 2.1 and evaluation conditions within each class.

Setting the Measurement Time
The measurement time is the time between the start of the measurement to the end of
the measurement.  The time for measuring harmonics is set in units of 1 s in advance.

The harmonics can be measured continuously for the specified time.  The measurement
time can be changed when equipment that emits harmonics that fluctuate over time is
measured or when confirming that the emitted harmonics do not change even when the

equipment is operated over extended time.

Setting the Title/Comment of Reports
A title or a comment of a report can be entered and saved or printed along with the

harmonic measurement data.  When printing, you can select whether to use color or
black and white.

Starting/Stopping Measurements
Harmonic measurement on the WT can be started from your PC when in On-Line mode.
The measurement cannot be started when in Off-Line mode.

When in Harmonic Measurement Mode
When harmonic measurement on the WT is started from the PC, the harmonics data
measured on the WT is retrieved and stored on the PC.  The next data is retrieved

and stored as next data.  All the data retrieved within the measurement time are
stored.  When the specified measurement time elapses, the measurement
automatically stops as well as the data retrieval.  You can also abort the measurement

and data retrieval from the PC before the specified measurement time elapses.

When in Harmonic Monitor or Waveform Monitor Mode
When harmonic measurement on the WT is started from the PC, the harmonics data

or waveform data measured on the WT is retrieved and stored on the PC.  When the
next data is retrieved, the previous data is updated and does not remain.  These
modes are used to monitor the conditions of the harmonics and waveforms and do not

evaluate against the standard as in Harmonic Measurement Mode.  To stop the
measurement and data retrieval in these modes, press the Stop button.

1.1  Functional Explanation
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Displaying the Evaluation Results and Measured Data/Waveform Data
The result of the evaluation as to whether the harmonic current data up to order 40 is

within the limits of IEC 61000-3-2 Edition 2.1 and the corresponding measured data can
be displayed.  Various displays below are possible only when in Harmonic Measurement
mode.

Display of the Evaluation Result within the Entire Measurement Time
Evaluation can be made as to whether all of the harmonic measurement data in the

measurement time are within the limits according to the settings specified in “Setting
the Standard and Measurement Environment” (as described earlier), and the results
can be displayed collectively.

Bar Graph Display of Harmonic Current/Voltage
Bar graphs of the harmonic measurement data and the standard limits can be
displayed for each order.  Moreover, the evaluation as to whether harmonic current

data is within the limits can be displayed using different colors.  The harmonic current
data to be evaluated is the mean value, the maximum value, and instantaneous
values (one set of harmonic measurement data) of the measured data within the

measured time.  Both harmonic current and voltage can be displayed for each input
element of the WT.

List Display of Harmonic Current/Voltage
A list of the harmonic measurement data and the standard limits can be displayed for
each order.  Moreover, the evaluation as to whether harmonic current data is within

the limits can be displayed using different colors.  The harmonic current data to be
evaluated is the mean value, the maximum value, and instantaneous values
(individual measurement data) of the measured data within the measured time.  Both

harmonic current and voltage can be displayed for each input element of the WT.

Fluctuation Graph Display of Harmonic Current
Graphs of the harmonic current fluctuation over time can be displayed for each order.

The lists can be displayed for each input element of the WT.

Waveform Display of Voltage/Current
The waveform immediately after the end of the measurement can be displayed.
Approximately 2 cycles of waveform is displayed using the WT2000, or approximately
4 cycles on the WT1600. You can place the cursor on the current waveform and read

the phase difference (phase angle) from the first zero-crossing point of the voltage
waveform and the current value of the phase.  The list can be displayed for each input
element of the WT.

Fluctuation Graph Display of Voltage/Current/Active Power
Graphs of the fluctuation of the rms value of the voltage and current as well as the
active power that is determined from the measured fundamental frequency and all

harmonics can be displayed.  The list can be displayed for each input element of the
WT.

Bar Graph Display of the Phase Angle of the Harmonic Current
Bar graphs of the phase angle of the harmonic current with respect to the
fundamental signal for each order can be displayed.  The list can be displayed for

each input element of the WT.

List Display of the Phase Angle of the Harmonic Current
A list of the phase angle of the harmonic current with respect to the fundamental

signal for each order can be displayed.  The list can be displayed for each input
element of the WT.

1.1  Functional Explanation
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1Saving and Loading Setup Information, Measured Data, and Waveform Data
Saving and Loading Setup Information

Setup information such as the measurement mode, standard and measurement
environment settings, measurement time, display format of bar graph and numerical
list, title/comment of reports (one-page reports containing the bar graph/numerical list

of the measured data and evaluation results) specified by the software can be saved.
The setup information saved to a file can also be loaded.

Saving and Loading Measured Data/Waveform Data
The harmonic measurement data or waveform data retrieved from the WT in
Harmonic Measurement mode into the PC using the software can be saved to a file.
In this case, the harmonic measurement conditions of the WT specified using the

software and the same data as the setup information described above are also saved.
The harmonic measurement data, waveform data, harmonic measurement conditions,
and setup information saved to a file can also be loaded.

Saving the Measured Data or Waveform Data in CSV Format
The harmonic measurement data or waveform data retrieved from the WT into the PC

using the software can be saved to a file in CSV format.  The software cannot load the
data saved to a CSV file.  Software applications installed on the PC that support files
in CSV format can open the data.

Saving and Printing Screen Images and Reports
Screen images and reports can be saved to files in BMP format or printed.

• The active window among the displayed graph and list windows can be saved in BMP
format or printed.

• A list or bar graph of the harmonic measurement data can be saved in BMP format or

printed as a report.  A title or comment can be attached to a report (see “Setting the
Title/Comment of Reports” on page 1-3).

1.1  Functional Explanation
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Repeatability of Measured Data
The maximum value and mean value in the harmonics measurement data saved to files

can be compared, and the difference in the measured data can be displayed on a bar
graph or numerical list for each order.  This function can be used to evaluate whether the
difference between data measured under the same measurement conditions when

harmonics are measured using the same product or same product model is within 5% as
defined in the standard (confirmation of repeatability).

File 1

Max1
Mean1

File 2

Max2
Mean2

File 3

Max3
Mean3

File N

MaxN
MeanN

Comparison Using Maximum Values

Mxmean Harmonic orders (2 to 40)

Mxmax

Mxmin

Mxmax – Mxmean
Mxmean

×100 is the 5% line

Mxmin – Mxmean
Mxmean

×100 is the –5% line

Mxmean = (Max1 + Max2 + Max3 + ... + MaxN)/N
(Mxmean: The value derived by summing the maximum values of each file (Max1,
Max2, Max3, ... MaxN) and dividing by the number of summed values (N).  The value
can be determined for each order.)

Mxmax = [Max1, Max2, Max3, ..., MaxN]max

(Mxmax: The maximum value among the maximum values of each file.  The value can
be determined for each order.)

Mxmin = [Max1, Max2, Max3, ..., MaxN]min

(Mxmin: The minimum value among the maximum values of each file.  The value can
be determined for each order.)

Comparison Using Mean Values
Comparison using mean values is obtained by replacing Mxmean, Mxmax, and Mxmin

with Mnmean, Mnmax, and Mnmin, respectively in the figure of the comparison using
maximum values.

Mnmean = (Mean1 + Mean2 + Mean3 + ... + MeanN)/N
(Mnmean: The value derived by summing the mean values of each file (Mean1,
Mean2, Mean3, ... MeanN) and dividing by the number of summed values (N).  The

value can be determined for each order.)
Mnmax = [Mean1, Mean2, Mean3, ..., MeanN]max

(Mnmax: The maximum value among the mean values of each file.  The value can be

determined for each order.)
Mnmin = [Mean1, Mean2, Mean3, ..., MeanN]min

(Mnmin: The minimum value among the mean values of each file.  The value can be

determined for each order.)

1.1  Functional Explanation
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11.2 System Requirements

Hardware
PC

A PC with a Celeron 500 MHz CPU or higher.

Internal Memory
128 MB or more.

Hard Disk
Free space of 10 MB or more.

GP-IB Interface Card or Board
(Not Required When Connecting to the WT1600 via Ethernet)

A GP-IB card or board made by National Instruments (version 1.60 or later) must be
installed in the PC.

Ethernet Communication Port (WT1600 Only)
A 10BASE-T/100BASE-TX compatible Ethernet communications port is required for
connecting to the WT1600 via Ethernet.

Disk Drive
One CD-ROM drive.  The drive is used to install the software.

Display
A display compatible with Windows 98, Windows Me, Windows XP Professional,

Windows NT 4.0 Workstation, or Windows 2000 Professional.  A resolution of 1024 ×
768 dots or higher analog RGB with 65,536 colors or more recommended.

Mouse or Pointing Device
A mouse or pointing device compatible with Windows 98, Windows Me, Windows XP
Professional, Windows NT 4.0 Workstation, or Windows 2000 Professional.

Printer
A printer compatible with Windows 98, Windows Me, Windows XP Professional,

Windows NT 4.0 Workstation, or Windows 2000 Professional.  A printer driver
compatible with Windows 98, Windows Me, Windows XP Professional, Windows NT
4.0 Workstation, or Windows 2000 Professional is required.  A color printer is

recommended.

OS
Windows 98, Windows Me, Windows XP Professional, Windows NT 4.0 Workstation, or
Windows 2000 Professional is required.

WT Digital Power Meter
WT2000 Series

The WT2010 or WT2030 Digital Power Meter with firmware (ROM) version 1.41 or

later, a GP-IB interface, and the harmonic analysis function.
WT1600

The WT1600 Digital Power Meter with firmware (ROM) version 2.07 or later, and a

GP-IB or Ethernet interface.
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1.3 Applicable Standard (IEC 61000-3-2 Edition 2.1)

The applicable standard of this software application is IEC 61000-3-2 (Electromagnetic
compatibility (EMC) - Part 3-2: Limits - Limits for harmonic current emissions (equipment
input current ≤ 16 A per phase)) Edition 2:2000 consolidated with amendment 1:2001,

abbreviated as IEC 61000-3-2 Edition 2.1, and EN61000-3-2 Amendment 14.  This
section gives an overview of the standard.  For further details, see the actual text of the
applicable standard.

Scope and Classification
The limits for harmonic current emissions (IEC61000-3-2) are applicable to electrical and

electronic equipment having an input current of up to 16 A per phase and connected to
public low-voltage distribution systems.  Classification is made depending on the type of
equipment.  IEC 61000-3-2 Edition 2.1 does not define the limits for some types of

equipment.  For details, see the applicable standard.

• Balanced three-phase equipment
• Household appliances, excluding 

equipment identified as Class D
• Tools excluding portable tools 

(portable tools are Class B)
• Dimmers for incandescent lamps
• Audio equipment
• Equipment not specified in one 

of the other three classes (B, C, 
and D)

Class A

 Portable tools

Class B

 Television receivers, personal computers (PCs), 
and PC monitors with a rated power of 600 W or 

Class D

 Lighting equipment

Class C

Electrical and electronic equipment having an input current up to 16 A per phase

Limits
The limits are specified for each class.  IEC 61000-3-2 assumes a phase voltage of 220
V, 230 V, and 240 V for specifying the limits.  For equipment of differing rated voltage,

conversion may be necessary.  For the conversion equation, see “Conversion of Limits”
(page 1-10).

Limits for Class A Equipment

Harmonic order

n
Odd harmonics

3
5
7
9

11
13

15≤n≤39
Even harmonics

2
4
6

8≤n≤40

Maximum permissible

harmonic current [A]

2.30
1.14
0.77
0.40
0.33
0.21

0.15×(15/n)

1.08
0.43
0.30

0.23×(8/n)

Limits for Class B Equipment

Limits for Class A equipment×1.5
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1

• Equipment with active input power exceeding 25 W

Harmonic order
n

2
3
5
7
9

11≤n≤39
(Odd harmonics only)

Maximum permissible harmonic current
expressed as a percentage of the input

current at the fundamental frequency [%]
2

30×λ*
10
7
5
3

• Equipment with active input power less than or equal to 25 W

Harmonic order
n

3
5

Maximum permissible harmonic current
expressed as a percentage of the input

current at the fundamental frequency [%]
86
61

Limits for Class C Equipment

Shall meet one of the two conditions below.
1. Does not exceed the power ratio limits of Class D.
2. The third and fifth harmonics shall not exceed the limits given in the table below.  

Moreover, the relationship of the fundamental voltage waveform and the input 
current waveform shall be as shown in the figure below.

0°

60 65° 90°

The relationship of the fundamental supply voltage waveform and the input current 

waveform is as follows, where the zero crossing of the fundamental supply voltage is 

assumed to be at 0° (degrees).

• Beginning of the current flow: Before or at 60°
• Last current peak: Before or at 65°
• End of the current flow: 90° or after

* λ is the power factor (circuit power factor).
 For the fundamental current and power factor, use the measured values 

under maximum load conditions of the equipment.

Classification is made according to the active power of the equipment shown 
below.  For single-phase equipment, the classification is made using the active 
power of the single-phase power.  For multi-phase equipment, the classification is 
made using the sum of the active powers all phases (three phases if three-phase).

Voltage

Current

Limits for Class D Equipment

Harmonic order
n

3
5
7
9
11

13≤n≤39
(Odd harmonics only)

Maximum permissible harmonic
current per watt [mA/W]

(Power ratio limit)

3.4
1.9
1.0
0.5
0.35

3.85/n

Maximum permissible
harmonic current

(Odd harmonics only)
[A]

2.30
1.14
0.77
0.43
0.33

Same as class A.

Shall meet the maximum permissible harmonic current (power ratio limit) per watt and 

the maximum permissible current given in the next table.  The concept of power 

(active power) of single- or multi-phase equipment is the same as Class C.

1.3  Applicable Standard (IEC 61000-3-2 Edition 2.1)
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Conversion of Limits

IEC 61000-3-2 assumes a phase voltage of 220 V, 230 V, and 240 V for specifying the 

limits.  For equipment of differing rated voltage, conversion may be necessary.  

Convert the limits of all the classes using the following equations and apply them.  

However, conversion to a phase voltage of 220 V or 240 V is not necessary.

Converted limit = Limit of each class ×
230

Rated voltage of the equipment

Phase voltage

Converted limit = Limit of each class ×
400

Rated voltage of the equipment

Line voltage of three-phase

Specifications of Supply Source, Measurement Equipment, Test Conditions, and
Application Method of Limits.

This section lists only the items.  For detailed specifications, see the applicable standard.
Power Supply

• Supply voltage and frequency range.
• Permissible range of harmonics contained in the supply voltage.
• Voltage peak value and phase offset between the waveform zero crossing and the

peak value.
• Internal impedance of the supply source.
• Angle between the fundamental voltage on each pair of phases in the case of a

three-phase source.

Measurement Equipment
• Error of the measurement equipment.
• Input impedance of the measurement equipment.
• Time constant of the internal processing when measuring harmonics.

Test Conditions
• Test conditions for television/audio equipment and lighting equipment.

• Test conditions for general equipment not specified in the applicable standard.
For example, performing tests by setting the equipment to a condition that
produces the maximum total harmonic current (THC).

• Specification of the repeatability of the measurement results.
• Specification of the observation time (measurement time) to achieve the

repeatability of the measurement results.

Application Method of Limits
• Derivation of the fundamental current and power factor (circuit power factor) of

class C equipment.
• Derivation of the power (active power) used by class D equipment
• Specifications when comparing the harmonic current limits and measured values

for each order.
• Compare the specified limit and the mean value of the harmonic current within

the measurement time and evaluate.

• Compare the value that is 1.5 times the specified limit and the maximum value
of the harmonic current within the measurement time and evaluate.

• Relaxation of the specification

If the total partial odd harmonic currents (POHC) of order above and including 21 is
less than the specified POHC limit, the average of the odd harmonic currents of
order above and including 21 is permitted to be 1.5 times the specified limits.

1.3  Applicable Standard (IEC 61000-3-2 Edition 2.1)
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11.4 Flow of Operation (GP-IB)

To display and evaluate harmonic measurement data using this software, the WT Digital
Power Meter and PC must be connected via the GP-IB interface, the software must be
installed, WT measurement conditions must be set, and evaluation conditions of the

applicable standard must be set.  Follow the steps below.

Preparation Flow Chart

Connect the WT and PC via GP-IB (section 2.1)

Install the software (section 2.4)

P
rep

aratio
n

On-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic 
Measurement

Measurement mode: Harmonic 
Monitor or Waveform Monitor

Execute the measurement
(section 3.8)

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)

Save setup information or
measured data (chapter 6)

Save screen images (section 7.1)

Execute the measurement
(chapter 5)

Monitor harmonics and
waveforms (chapter 5)

Print screen images
(sections 7.3 to 7.5)Save screen

images (section 7.1)

Select the WT GP-IB
address (section 2.5)

Set the WT measurement
conditions (section 3.4)

Set the evaluation conditions of
the standard (sections 3.6 and 3.7)

Set standard and measurement
environment (section 3.6)
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d

 evalu
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n

s
E
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t

P
ro

cess th
e

m
easu

red
 resu

lts

Online or
Offline

(section 2.5)

Select WT
(section 2.5)

Select the measurement
mode (section 3.5)

Online

Select the WT GP-IBaddress 
(WT1600:section 3.1)
(WT2000:section 3.2)

Select Online
(section 3.3)

Offline

Switch from
Offline to Online

(see the next page)



1-12 IM 761922-01E

Off-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic Measurement 

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)Save the setup

information (section 6.1)

Set standard and measurement
environment (section 3.6)

S
et th

e evalu
atio

n
 co

n
d

itio
n

s
P

ro
cess th

e resu
lts

Online or Offline
(section 2.5)

Online

Load the setup information or
measured data (sections 3.10 and 6.2)

Select Offline
(section 3.9)

Offline

(See the previous page)

Switch from
Online to Offline

1.4  Flow of Operation (GP-IB)
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11.5 Flow of Operation (Ethernet : WT1600 Option)

To display and evaluate harmonic measurement data using this software, the WT Digital
Power Meter and PC must be connected via the GP-IB interface, the software must be
installed, WT measurement conditions must be set, and evaluation conditions of the

applicable standard must be set.  Follow the steps below.

Preparation Flow Chart

Connect the WT and PC via Ethernet (section 2.1)

Install the software (section 2.4)

P
re

p
a

ra
tio

n

On-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic 
Measurement

Measurement mode: Harmonic 
Monitor or Waveform Monitor

Execute the measurement
(section 3.8)

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)

Save setup information or
measured data (chapter 6)

Save screen images (section 7.1)

Execute the measurement
(chapter 5)

Monitor harmonics and
waveforms (chapter 5)

Print screen images
(sections 7.3 to 7.5)Save screen

images (section 7.1)

Select the WT Ethernet (TCP-IP) 
(section 2.5)

Set the WT measurement
conditions (section 3.4)

Set the evaluation conditions of
the standard (sections 3.6 and 3.7)

Set standard and measurement
environment (section 3.6)

S
et m

easu
rem

en
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n
d

itio
n
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d

 evalu
atio

n
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d

itio
n

s
E

xecu
te th

e
m

easu
rem

en
t

P
ro

cess th
e

m
easu

red
 resu

lts

Online or
Offline

(section 2.5)

Select WT
(section 2.5)

Select the measurement
mode (section 3.5)

Online

Select the WT Ethernet (TCP-IP) 
(WT1600:section 3.1)
(WT2000:section 3.2)

Select Online
(section 3.3)

Offline

Switch from
Offline to Online

(see the next page)
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Off-Line Mode Flow Chart

Start the software (section 2.5)

Measurement mode: Harmonic Measurement 

Display the evaluation results and
measured data (chapter 4)

Print
(chapter 7)Save the setup

information (section 6.1)

Set standard and measurement
environment (section 3.6)

S
et th

e evalu
atio

n
 co

n
d

itio
n

s
P

ro
cess th

e resu
lts

Online or Offline
(section 2.5)

Online

Load the setup information or
measured data (sections 3.10 and 6.2)

Select Offline
(section 3.9)

Offline

(See the previous page)

Switch from
Online to Offline

1.5  Flow of Operation (Ethernet : WT1600 Option)
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Chapter 2 Preparation before Use

2.1 Connecting the WT Digital Power Meter and the
PC

The WT digital power meter and PC are connected using the GP-IB or Ethernet
(WT1600 option) interface.  Connect the GP-IB or Ethernet cable with the power to both

the WT digital power meter and the PC turned OFF.

Connecting the GP-IB Cable to the WT
Check that the power to the WT is turned OFF and connect the GP-IB cable to the GP-IB
connector on the WT rear panel.

Connecting the GP-IB Cable to the PC
Check that the power to the PC is turned OFF and connect the other end of the GP-IB
cable to the GP-IB connector on the PC.

PC

WT

GP-IB connector on the PC

To the GP-IB connector on the WT

GP-IB cable

WT rear panel

GP-IB connector

GP-IB
cable

Setting the GP-IB Address of the WT2000
Turn ON the power to the WT.  After an opening message appears, the WT is ready to
make measurements.  Press the LOCAL key on the WT front panel.  GP-IB
communication settings can now be entered.  Set the items as follows.

Mode
Addr A (Addressable mode A)

Address
Addr _ _
Select the GP-IB address in the range of 1 to 30.  Do not select 0, because address 0
is reserved for use on the PC.

Terminator
tErM  Cr+LF

For the setup procedure, see the WT User’s Manual.
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Setting GP-IB the Address of the WT1600

Keys

RESET SELECT

INPUT

MOTOR  SET

RANGE

FILTER

START STOP SYNC  SRC

AVG

SCALING

SINGLE STORE  SET

REMOTE

MAX  HOLD NULL

MENU

HARMONICS

TRIG'D

CURSOR

DISPLAY FILE

LOCAL MISC

SHIFT

COPYSTORE

WAVE

HOLD UP  DATE
RATE

WIRING

INTEGRATOR

INTEG SET RESET

ESC

MEASURE

CAL

To exit the menu during operation, press ESC.

Procedure
1. Press MISC to display the Misc menu.

2. Press the Communication soft key.
3. Press the Comm Device soft key to display the GP-IB menu.
4. Turn the jog shuttle to set the address.

ESC ESC

Explanation
Carry out the following settings when using a controller to set information that can be
specified through key operation on the WT1600 or when outputting setting parameters or

output waveform display data to the controller.

Setting the Address
Set the address of the WT1600 within the following range for the addressable mode.

0 to 30
Each device that can be connected via GP-IB has a unique address within the GP-IB
system.  This address is used to distinguish the device from others.  Therefore, when

you connect the WT1600 to a PC, for example, make sure to assign a unique address
to the WT1600.

Note
Do not change the address while the controller or other devices are using the GP-IB system.

2.1  Connecting the WT Digital Power Meter and the PC
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Network Connection (WT1600 Option)
To connect to a network, connect a UTP (Unshielded Twisted-Pair) cable or an STP

(Shielded Twisted-Pair) cable that is connected to a hub, for example, to the 10BASE-T
port on the rear panel of the WT1600.

PC

10BASE-T HUB or router

UTP cable
or

STP cable
(straight)

NIC

WT1600
10BASE-T port

RJ-45 modular jack

One-to-One Connection (WT1600 Option)
Even when connecting the WT1600 and a PC in a one-to-one configuration, connect
them via a hub as shown below.

PC

10BASE-T HUB
or router

UTP
cable

or
STP

cable
(straight)

NIC

WT1600

Note
• When connecting the WT1600 and a PC in a one-to-one configuration, use a 10BASE-T/

100BASE-TX auto switching NIC or a 10BASE-T NIC on the PC side.

• Avoid connecting the WT1600 and a PC directly without going through a hub.  Operations are

not guaranteed for communications using direct connection.

2.1  Connecting the WT Digital Power Meter and the PC
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2.2 Setting the Ethernet Interface (TCP/IP)

Keys

RESET SELECT

INPUT

MOTOR  SET

RANGE

FILTER

START STOP SYNC  SRC

AVG

SCALING

SINGLE STORE  SET

REMOTE

MAX  HOLD NULL

MENU

HARMONICS

TRIG'D

CURSOR

DISPLAY FILE

LOCAL MISC

SHIFT

COPYSTORE

WAVE

HOLD UP  DATE
RATE

WIRING

INTEGRATOR

INTEG SET RESET

ESC

MEASURE

CAL

To exit the menu during operation, press ESC.

Procedure
1. Press MISC to display the Misc menu.

2. Press the Next 1/2 soft key to display the Next 2/2 menu.
3. Press the Network soft key to display the Network menu.

ESCESC

4. Press the TCP/IP Setup soft key to display the TCP/IP Setup dialog box.

ESC
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When Using Only DHCP
5. Turn the jog shuttle to select DHCP.

6. Press SELECT to select ON.
7. Turn the jog shuttle to select DNS.
8. Press SELECT to display the DNS selection box.

9. Turn the jog shuttle to select OFF.

When Using Only DNS
5. Turn the jog shuttle to select DHCP.
6. Press SELECT to select OFF.

Entering the IP Address
7. Turn the jog shuttle to select IP Address.
8. Press SELECT to display the IP address entry box.

9. Turn the jog shuttle to enter the IP address of the WT1600.
10. Press SELECT or ESC to close the box.
11. Enter all four octets of the IP address.

Entering the Subnet Mask
Enter the subnet mask according to the system or network to which the WT1600

belongs.  If the subnet mask is not required, proceed to “Entering the Default
Gateway.”
12. Turn the jog shuttle to select Net Mask.

13. Enter all four octets of the subnet mask of the network to which the WT1600
belongs in the same fashion as the IP address.

Entering the Default Gateway
Enter the default gateway according to the system or network to which the WT1600
belongs.  If the default gateway is not required, proceed to “Turning ON the DNS.”

14. Turn the jog shuttle to select Gate Way.
15. Enter all four octets of the default gateway of the network to which the WT1600

belongs in the same fashion as the IP address.

2.2  Setting the Ethernet Interface (TCP/IP)
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Turning ON the DNS
16. Turn the jog shuttle to select DNS.

17. Press SELECT to display the DNS selection box.
18. Turn the jog shuttle to select ON.
19. Press SELECT to confirm the DNS ON setting.

Entering the Domain Name
Enter the domain name of the system or network to which the WT1600 belongs.

20. Turn the jog shuttle to select Domain Name.
21. Press SELECT to display the keyboard.
22. Use the keyboard to enter the domain name of the network to which the

WT1600 belongs.

Entering the Address of the Primary DNS Server
23. Turn the jog shuttle to select DNS Server1.
24. Enter all four octets of the primary DNS server address in the same fashion as

the IP address.

Entering the Address of the Secondary DNS Server
Enter the information if the system or network to which the WT1600 belongs uses a

secondary DNS server.  If a secondary server is not used, proceed to “Entering the
Primary Domain Suffix.”
25. Turn the jog shuttle to select DNS Server2.

26. Enter all four octets of the secondary DNS server address in the same fashion
as the IP address.

Entering the Primary Domain Suffix
Enter the information if a domain suffix is required.
27. Turn the jog shuttle to select Domain Suffix1.

28. Enter the primary domain suffix in the same fashion as the IP address.

Entering the Secondary Domain Suffix
Enter the information if a secondary domain suffix is present.
29. Turn the jog shuttle to select Domain Suffix2.
30. Enter the secondary domain suffix in the same fashion as the IP address.

2.2  Setting the Ethernet Interface (TCP/IP)
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When Using Both DHCP and DNS
5. Turn the jog shuttle to select DHCP.

6. Press SELECT to select ON.
7. Turn the jog shuttle to select DNS.
8. Press SELECT to display the DNS selection box.

9. Turn the jog shuttle to select ON or Auto.
If you selected ON, you must enter information according to “Entering the
Domain Name” through “Entering the Secondary Domain Suffix” on the previous

page.
If you selected Auto, the entry information from “Entering the Domain Name” to
“Entering the Secondary Domain Suffix” is automatically set by the DHCP

server.  Therefore, you do not have to enter the information.

Explanation
To use the Ethernet communication functions of the WT1600, DHCP, IP address, IP

address, subnet mask, default gateway, and DNS must be specified.
Consult your system or network administrator in setting these parameters.

DHCP (Dynamic Host Configuration Protocol)
• The IP address, subnet mask, default gateway, and DNS can be automatically

specified by using DHCP.
• To use DHCP, the network must have a DHCP server.

• Consult your network administrator to see if DHCP can be used.
• If you use DHCP, a different IP address may be assigned every time the WT1600

is powered up.  You must be careful when using the FTP server function of the

WT1600.

IP Address (Internet Protocol Address)
• Enter the IP address assigned to the WT1600.  The default setting is “0.0.0.0.”
• The IP address is used to uniquely identify a device on the Internet when using

TCP/IP.  The address is a 32-bit value expressed using four octets (each 0 to 255),

each separated by a period as in [192.168.111.24].
• A unique IP address must be obtained from the network administrator.
• If DHCP can be used, the address is automatically assigned.

2.2  Setting the Ethernet Interface (TCP/IP)
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Subnet Mask
• Enter the mask value used when determining the subnet network address from the

IP address.  The default setting is “255.255.255.0.”
• Consult your network administrator for the appropriate value.  You may not need to

set the value.

• If DHCP can be used, the subnet mask is automatically assigned.

Default Gateway
• Enter the IP address of the default gateway that is used when communicating with

other devices on a different segment (network unit).  The default setting is “0.0.0.0.”
• Consult your network administrator for the appropriate value.  You may not need to

set the value.
• If DHCP can be used, the default gateway is automatically assigned.

DNS (Domain Name System)
DNS is a system used to associate names used on the Internet called host names
and domain names to IP addresses.  Given AAA.BBBBB.com, AAA is the host name

and BBBBB.com is the domain name.  Instead of using the IP address, which is a
sequence of numbers, host name and domain name can be used to access the
network.

• Enter the domain name, the DNS server address, and the domain suffix.  If DHCP
can be used, these values are automatically assigned.

• When accessing a network drive or a network printer from the WT1600, a name

can be used to access the destination rather than an IP address.

• Entering the domain name
• Enter the network domain name that the WT1600 belongs to.
• Enter up to 30 characters.
• The characters that can be used are 0-9, A-Z, %, _, ( ) (parenthesis), - (minus

sign).

• Entering the DNS server address
• Enter the IP address of the DNS server.  The default setting is “0.0.0.0.”
• You can specify up to two DNS server addresses, primary and secondary.

When the primary DNS server is down, the secondary DNS server is

automatically looked up for the mapping of the host name/domain name and IP
address.

• Entering the Domain Suffix
• When the IP address corresponding to the server name with the domain name

specified in the previous section is not found, the system may be set up to

search using a different domain name.  Enter this alternate domain name as the
domain suffix.

• You can specify up to two domain suffixes, primary and secondary.

Note
• If you changed settings related to the Ethernet network, the WT1600 must be power cycled.

• If the WT1600 is turned ON with the DHCP function enabled without an Ethernet cable

connected, communications and file functions may not operate properly.  In this case, turn

DHCP OFF and power cycle the WT1600.

2.2  Setting the Ethernet Interface (TCP/IP)
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Configuring the TCP/IP Settings of the PC

Communication parameters such as the IP address must be specified also on the PC side.

Communication parameters are specified for each Ethernet NIC that is installed in the PC.

Here, the settings of the NIC required for connecting your PC and the WT1600 are explained.

If the IP address and other parameters are to be assigned dynamically using the DHCP

server, the following settings are not necessary.

Select Obtain an IP address automatically under the IP Address tab of the TCP/IP

Properties dialog box.

For example, if you are connecting a PC and the WT1600 to an independent Ethernet

network, you can specify parameters as indicated in the next table.  For details on the

parameters, consult your system or network administrator.

Parameter Value Notes

IP address (Example) 192.168.21.128 IP address for the PC
Subnet mask (Example) 255.255.255.0 Set the same value as the subnet mask that was

specified for the WT1600.
Gateway None
DNS Not used
WINS Not used

The following procedure describes the steps for Windows 95/98.  If you are using Windows

NT/2000 Pro carry out equivalent steps according to your operating system.

1. Select Start > Settings > Control Panel.  The Control Panel opens.

2. Double-click the Network icon to display the Network dialog box.

3. Select TCP/IP corresponding to the Ethernet NIC that is connected to your PC and click

Properties.  The TCP/IP Properties dialog box appears.

4. Set the parameters such as the IP address according to the table above and click OK.

    

2.2  Setting the Ethernet Interface (TCP/IP)
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2.3 Ethernet Control Settings

Keys

RESET SELECT

INPUT

MOTOR  SET

RANGE

FILTER

START STOP SYNC  SRC

AVG

SCALING

SINGLE STORE  SET

REMOTE

MAX  HOLD NULL

MENU

HARMONICS

TRIG'D

CURSOR

DISPLAY FILE

LOCAL MISC

SHIFT

COPYSTORE

WAVE

HOLD UP  DATE
RATE

WIRING

INTEGRATOR

INTEG SET RESET

ESC

MEASURE

CAL

To exit the menu during operation, press ESC.

rocedure
Select the communications interface to be used for controlling the WT.
1. Press MISC to display the Misc menu.

2. Press the Communication soft key to display the Comm menu.
3. Press the Comm Device soft key to display the Comm Device menu.
4. Press the Network soft key.  Doing so selects Ethernet as the interface for

controlling the WT.

ESC ESCESC ESC

For Suffix Code -C1 (GP-IB) For Suffix Code -C2 (Serial)

ESC

Note
Only the communications interfaces selected under Device are available. If commands are

sent using an unselected communications interface, the command will not be received.
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Setting the User Name and Password
5. Press the User Account soft key to display the User Account dialog box.

6. Turn the jog shuttle to select User Name.
7. Press SELECT to display the keyboard.
8. Use the keyboard to enter the user name.

9. Turn the jog shuttle to select Password.  The password setting is entered twice.
10. Press SELECT to display the keyboard.
11. Use the keyboard to enter the password.  Password is not required if the user

name is anonymous.

Setting the Timeout Time
12. Turn the jog shuttle to select Time Out.
13. Press SELECT to display the timeout time selection box.
14. Turn the jog shuttle to set the timeout time.

15. Press SELECT or ESC to close the box.

ESC

Entering TCP/IP Settings
You must enter TCP/IP settings to control the WT from a PC using the Ethernet
interface.  For instructions on entering settings, see section 2.2 “Setting the Ethernet
Interface (TCP/IP)” .

2.3  Ethernet Control Settings
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Explanation
You can control the WT from a PC using the Ethernet interface.  To enable this function,
you must confirm that your WT is running ROM version 2.07 or later, and that
YOKOGAWA’s dedicated software has been installed on the PC according to the

instructions above.
Retail Software
WTViewer (Model 760122) version 2.00 or later.

A trial version is available and can be downloaded from the following URL.
http://www.yokogawa.com/tm/Bu/760122/

Free Software
Wirepuller version 1.02 or later.
Wirepuller can be downloaded from the following URL.

http://www.yokogawa.com/tm/Bu/DLsoft/wire/

Setting the User Name
• Enter the user name to allow access to the WT1600.
• Enter up to 15 characters.
• The characters that can be used are 0-9, A-Z, %, _, ( ) (parenthesis), - (minus sign).

• If you specify anonymous, the WT1600 can be accessed from the outside (PC)
without a password.

Setting the Password
• Enter the password for the user name to allow access to the WT1600.
• Enter up to 15 characters.

• The characters that can be used are 0-9, A-Z, %, _, ( ) (parenthesis), - (minus sign).
• If the user name is set to anonymous, the WT1600 can be accessed from the outside

(PC) without a password.  The password setting is entered twice.

Setting the Timeout Time
The WT1600 closes the connection to the network if there is no access for a certain
period of time (timeout time).

The available settings are 0 to 3600 s, or Infinite.  The default value is Infinite.

Note
The settings will not take effect until the unit is turned OFF then back ON again.

2.3  Ethernet Control Settings
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2.4 Installing the Software

Procedure
The following procedures are for installing the software on Windows 2000 Professional.

The screens shown in the figure may vary depending on the OS that is running on the
PC.

1. Start Windows.
When using Windows NT 4.0 or Windows 2000, set the user name to Administrator

when starting up.

2. Place the installation CD-ROM containing the software into the CD-ROM drive.
3. Double-click My Computer, then the CD-ROM icon.

4. Double-click Setup.exe.  InstallShield Wizard starts.

Start Screen of InstallShield Wizard

5. Click Next.
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6. If you accept the terms of the license agreement, select Yes.  If you do not,
select No.

Proceed to step 7.

Return to the previous screen.

Abort the installation.

When Yes is selected When No is selected

7. Select the installation destination, and click Next.
If you click Browse, you can specify the installation destination.  The default installation

destination is set to “C:\Program Files\Yokogawa\Harmonic Analysis.”

2.4  Installing the Software
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8. Select the program folder where the program icon is to be added and click Next.
The installation starts.

The program icon (shortcut) of the software is added in the Programs menu within the

Start menu.  The destination is selected here.  The default program folder is

Yokogawa.

9. If the installation completes successfully, a message “Setup has finished
installing” is displayed.  Click Finish.

2.4  Installing the Software
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2.5 Starting and Exiting the Software

Procedure

Starting the Software
Starting the Software

1. From the Start menu, choose Programs > Yokogawa > Harmonic Analysis >

IEC61000-3-2.  The software starts.
The procedure above applies when the default software installation destination and

program folder are used.  If you changed the installation destination or program folder

at installation, select the corresponding location.

2. When you start the software, a dialog box appears for you to select the WT
model.

Selecting the WT Model
3. Select either WT2000 or WT1600.

Selecting the Communications Mode
4. Select Online or Offline.

• If You Selected Online
If you selected the WT2000, proceed to step 5.
If you selected the WT1600, proceed to step 6.

• If you selected Offline, go to section 3.10.
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Selecting the Communication Address
5. In the Initialize Interface dialog box that is displayed, select the GP-IB address

of the WT.

Note
GP-IB address 0 cannot be selected because it is reserved for use by the PC.

Select the GP-IB address and click OK to start communications with the WT.  After
automatically confirming that communications are possible, an acquisition data
window appears.  Setup and execution of measurements are now possible.

Acquisition Data Window
For a detailed description of the acquisition data window, see section 3.7.

Note
If the power to the WT is not ON or the WT is not ready to make measurements, an error

occurs when communications are started after selecting the GP-IB address and clicking OK.

A communications error also occurs if the GP-IB address is not correct or if there is no

response from the WT.

Selecting the Communications Interface (WT1600 Only)
6. Select GP-IB or Ethernet.

If you selected GP-IB, proceed to step 5.

If you selected Ethernet, proceed to step 7.

2.5  Starting and Exiting the Software
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7. In the Connection dialog box, enter the IP address, user name, and password of
the target WT.

Select the GP-IB address and click OK to start communications with the WT.  After

automatically confirming that communications are possible, an acquisition data
window appears.  Setup and execution of measurements are now possible.

Acquisition Data Window
For a detailed description of the acquisition data window, see section 3.7.

Note
If you enter settings in the Connection dialog box then click OK to begin communications, an

error will occur if the power to the WT is not ON or if it is not ready to perform measurement.

An error also occurs if the IP address, user name, or password is not correct, or if no

response was received from the WT.

Exiting the Software
Choose Exit from the File menu or click the  button at the upper right corner of the
Harmonic Analysis Software window.  The software closes.

2.5  Starting and Exiting the Software
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Explanation
A shortcut is located in the Programs folder of the Start menu.  You can start the
software by selecting the shortcut.  The software is saved to the installation destination
that was specified during installation described earlier.

Selecting the WT Model
Select WT2000 or WT1600.

• WT1600
When a communication mode is selected, you can download saved data or settings
from a WT1600 that is online.

• WT2000
When a communication mode is selected, you can download saved data or settings
from a WT2000 that is online.

Selecting the Communications Mode
You can select Online or Offline.

• Online
If Online is selected, you must select the GP-IB address of the target WT.  (If you
selected the WT1600, you must select a communication interface.)

• Offline
If Offline is selected, communications cannot be performed with the WT.  However,
you can load, display, and print measured data or settings that have been previously

saved.  Continue on to section 3.9.

Selecting the Communications Interface
• GP-IB

You must select the GP-IB address of the target WT1600.
• Ethernet

You must enter the IP address, user name, and password of the target WT1600.

Selecting the Communications Address
• GP-IB

• You can select the GP-IB address of the target WT.
The selectable range is 1 to 30.

•  Ethernet
• Enter the IP address of the target WT.

You can enter an address from 0.0.0.0 to 255.255.255.255.

• You can enter the user name and password of the target WT.
Characters That Can Be Used on the WT1600

Starting Communication
When you select a communication address and click OK, communications with the WT
are started.

2.5  Starting and Exiting the Software
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Chapter 3 Retrieving and Loading Measured Data/Waveform Data to Be Evaluated

3.1 Initialize Interface (WT1600)

Procedure
1. From the Communications menu, choose Initialize Interface.  The Initialize

Interface dialog box opens.

2. Select the communications interface.

If you selected GP-IB, proceed to step 3.

If you selected Ethernet, proceed to step 4.

3. If you selected GP-IB in step 2, select the GP-IB address for the target WT.

Note
GP-IB address 0 cannot be selected, because it is reserved for use by the PC.

4. If you selected Ethernet in step 2, enter the IP address, user name, and
password of the target WT.

Explanation
When changing the communication mode from Off-Line to On-Line, the GP-IB address of
the target WT must be selected.

Selecting the Communications Address
GP-IB
• You can select the GP-IB address of the target WT.

The selectable range is 1 to 30.
Ethernet
• Enter the IP address of the target WT.

You can enter an address from 0.0.0.0 to 255.255.255.255.
• Enter the user name and password of the target WT.

Characters That Can Be Set on the WT
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3.2 Initialize Interface (WT2000)

Procedure
1. From the Communications menu, choose Initialize Interface.  The Initialize

Interface dialog box opens.

2. Select the GP-IB address of the target WT.

Note
GP-IB address 0 cannot be selected, because it is reserved for use by the PC.

Explanation
When changing the communication mode from Off-Line to On-Line, the GP-IB address of
the target WT must be selected.

Selecting the Address
You can select the GP-IB address of the target WT.
The selectable range is 1 to 30.
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3.3 Enabling On-Line Mode

Procedure
Use the following procedure after entering settings on the target instrument
according to the procedures given in sections 3.1 and 3.2.

From the Communications menu, choose On-Line.  Communications start with

the target WT.

On the status bar of the window, check that Online is indicated.

Online

Note
When starting communications, an error will occur if the power to the WT is not ON or the WT

is not ready to perform measurement.  An error also occurs if the GP-IB address, IP address,

user name, or password is incorrect, or if no response was received from the target

instrument.

Explanation
When changing the communication mode from Offline to Online, select Online from the

menu after entering settings on the target WT.  When you select Online from the menu,
communication with the target WT begins. When communication begins, harmonic
measurement conditions of the WT are loaded into the software.
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3.4 Setting the Measurement Conditions of the WT

Procedure
From the Setting menu, choose WT Setting.  The WT Setting dialog box

opens.  You can also choose WT Setting from the Setup icon on the toolbar.
You can set the measurement conditions of the target WT.

     

Explanation
The measurement conditions of the WT can be set from this software via the GP-IB or
Ethernet interface (WT1600 option).  For information about the settings, see “Setting
Measurement Conditions of the WT” in chapter 8.
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3.5 Setting the Measurement Mode to Harmonic
Measurement

Procedure
1. From the Setting menu, choose Measurement Mode.  The Measurement mode

setup dialog box opens.  You can also click  on the toolbar.

2. Choose Harmonic Measurement.
3. Click OK.  The Acquisition data window opens.

For details on the Acquisition data window, see section 3.7.

Explanation
To retrieve harmonic measurement data from the WT and evaluate the data according to

the IEC standard (see section 1.3), you must set the measurement mode to Harmonic
Measurement.  For a description of the function used to display the evaluation results
and measured data, see chapter 4.

Measurement Mode
The following three measurement modes are available.

• Harmonic Measurement Mode
This mode is used to retrieve harmonics measurement data from the WT and

evaluate the data according to the IEC standard (see section 1.3).  When the
communication mode is set to On-Line, evaluation can be made according to the
IEC standard while making harmonic measurements on the WT.  When the

communication mode is set to Off-Line, evaluation can be made on the
measurement data loaded from files according to the IEC standard.

• Harmonic Monitor Mode
Harmonic fluctuation can be monitored on bar graphs and numerical lists while
making harmonic measurements on the WT.  This mode can be selected only

when in On-Line mode.

• Waveform Monitor Mode
The measured waveform can be monitored while making harmonic measurements
on the WT.  This mode can be selected only when in On-Line mode.

Note
When you switch the measurement mode, all the data retrieved and loaded up to that point

are cleared.  It is recommended that the data retrieved using Harmonic Measurement Mode

be saved (see section 6.1) before changing the measurement mode.
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3.6 Setting the Standard and Measurement
Environment

Procedure
1. From the Setting menu, choose Standard and Measurement Environmental

Setup.  The Standard and Measurement Environmental Setup dialog box

opens.  You can also choose Standard and Measurement Environmental
Setup from the Setup icon on the toolbar.

2. From the Evaluate Class list in the Standard and Measurement Environmental
Setup dialog box, select the class of the EUT from A, B, C, and D according to
the specifications in the applicable standard.  The setup information varies

depending on the selected class.

Setting Class A or Class B
Set the class according to the explanation in the figure below.

Select the lower power limit for 
applying the limits
Select 50 W or 75 W.  When the active 
power of the EUT is less than the 
selected power, the limits are not applied.

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the 
value.  The limits are derived from to 
the specified system voltage.
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Setting Class C
Set the class according to the explanation in the figure below.

• When the active power from the equipment exceeds 25 W (>25 W)

Measure the fundamental current and power 
factor
Set the load of the EUT to the maximum and click 
Pre-Meas.  The fundamental current and power 
factor are measured, and the values are displayed.

Set the supply voltage
Set the phase voltage or line voltage of the EUT.  You can also enter 
the value.  The limits are derived from the specified system voltage.

Fundamental current
The measured current at the fundamental 
frequency is displayed for each input 
element of the WT (e1, e2, and e3 denote 
element 1, element 2, and element 3, 
respectively).  You can also enter the 

Power factor
The measured power 
factor is displayed.  You 
can also enter the 

• When the active power from the equipment is less than or equal to 25 W (<=25 W)
You can select whether to evaluate by applying the power ratio limit of class D or to
evaluate on the conditions of harmonic order 3 and 5.

Measure the fundamental current
Set the load of the EUT to the maximum and 
click Pre-Meas.  The fundamental current is 

measured, and the values are displayed.  

Select the power
When applying the power ratio limits of 
Class D, select to use the maximum power 
measured by the EUT or a specified power 
value.

Evaluating by applying the power ratio
limits of Class D

Evaluating on the conditions of
harmonic order 3 and 5

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the 
value.  The limits are derived from to 
the specified system voltage.

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the 
value.  The limits are derived from to 
the specified system voltage.

3.6  Setting the Standard and Measurement Environment
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Setting Class D
Set the class according to the explanation in the figure below.

Select the lower power limit for 
applying the limits
Select 50 W or 75 W.  When the active 
power of the EUT is less than the selected 
power, the limits are not applied.

Select the supply voltage
Select the phase voltage or line voltage 
of the EUT.  You can also enter the value.  
The limits are derived from to the 
specified system voltage.

Select the power
When applying the power ratio limits of 
Class D, select to use the maximum 
power measured by the EUT or a 
specified power value.

Explanation
To retrieve harmonic measurement data from the WT and measure/evaluate the data
according to the IEC standard (see section 1.3), you must select the class of the EUT
according to the specifications of the applicable standard and set the evaluation

conditions in each class.  Here, the procedure for switching the evaluation conditions for
each class is explained.  For a description of the classification specified in the standard
and the harmonic limits for each class, see section 1.3 or the applicable standard.

Standard (Regulation)
The software can make measurements and evaluations according to the IEC standard
(see section 1.3).  This item cannot be switched.

Class (Evaluate Class)
Select the class from A, B, C, and D, according to the classifications specified in the

standard.  The setup information varies depending on the class selected here.

Setting Class A
• Selecting the System Voltage

You can select the system voltage of the EUT or enter the value.  If the wiring
system is single-phase two-wire (1P2W), single-phase three-wire (1P3W), or three-

phase four-wire (3P4W), select or enter the phase voltage; if the wiring system is
three-phase three-wire (3P3W) or three-voltage three-current (3V3A), select or
enter the line voltage.  The limits are derived from the specified system voltage.
* Depending on the model, the “phase” is denoted as φ not P.

• Selecting the Lower Power Limit for Applying the Limits
Select 50 W or 75 W.  When the active power of the EUT is less than the selected
power, the limits are not applied.

3.6  Setting the Standard and Measurement Environment
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Setting Class B
The setup information is the same as class A.  The limits applied are 1.5 times the

limits for class A.

Setting Class C When the Active Power of the EUT Exceeds 25 W (>25 W)
• Selecting the System Voltage

Same as class A.
• Measuring the Fundamental Current and Power Factor

Measure the fundamental current and the power factor of the EUT that are required

for defining the limits.  Make the measurement by setting the load of the EUT to the
maximum.
Displaying the Current at the Fundamental Frequency
The measured current at the fundamental frequency is displayed for each input
element of the WT (e1, e2, and e3 denote element 1, element 2, and element 3,
respectively.  You can also enter the value.

Displaying the Power Factor
The measured power factor is displayed.  You can also enter the value.

Setting Class C When the Active Power of the EUT Is Less Than or Equal to 25 W
(<=25 W)

The IEC standard specifies that either “the power ratio limits of class D” or “the

conditions of harmonic order 3 and 5” are met.
• Evaluating by Applying the Power Ratio Limits of Class D

The same power ratio limit of class D is applied.

Selecting the System Voltage
Same as class A.
Selecting the Power
You can select to use the maximum power measured by the EUT or a specified
power value.

• Evaluating on the Conditions of Harmonic Order 3 and 5
The IEC standard specifies the current ratio of harmonic order 3 and 5 to the
fundamental frequency and the relationship between the fundamental current and
the current waveform (see page 1-9).

Selecting the System Voltage
Same as class A.
Measuring the Fundamental Current
Measure the fundamental current of the EUT that is required for defining the limits.
Make the measurement by setting the load of the EUT to the maximum.
Displaying the Current at the Fundamental Frequency
The measured current at the fundamental frequency is displayed for each input
element of the WT (e1, e2, and e3 denote element 1, element 2, and element 3,
respectively.  You can also enter the value.

Setting Class D
• Selecting the System Voltage

Same as class A.
• Selecting the Power

You can select to use the maximum power measured by the EUT or a specified

power value.
• Selecting the Lower Power Limit for Applying the Limits

Select 50 W or 75 W.  When the active power of the EUT is less than the selected

power, the limits are not applied.

3.6  Setting the Standard and Measurement Environment
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3.7 Setting the Measurement Time

Procedure
1. From the Setting menu, choose Measurement Time Setup.  The Measurement

Time Setup dialog box opens.  You can also choose Measurement Time Setup
from the Setup icon on the toolbar.

2. Set the measurement time.

Explanation
Measurement Time

The measurement time is the time between the start of the measurement to the end of

the measurement.  The time for measuring harmonics can be set in advance.  The
harmonics can be measured continuously for the specified time.  The measurement
time can be changed when equipment that emits harmonics that fluctuate over time is
measured or when confirming that the emitted harmonics do not change even when

the equipment is operated over extended time.

Selectable range: 0 H 0 M 1 S to 24 H 0 M 0 S in units of 1 s.

• An error occurs if a time exceeding 24 hours is specified.
• If the measurement time is set to 0 H 0 M 0 S and the measurement is started,

measurement continues until you choose Stop from the Measure menu or click

Stop on the toolbar.

Note
Depending on the characteristics of the PC onto which this software was installed, an error

occurs if you specify a time longer than the amount of memory that can be reserved.  In this

case, you may be able to increase the available time by exiting other applications or by

increasing the amount of memory available to the PC.
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3.8 Starting and Stopping Measurements
(Retrieving Measured Data/Waveform Data)

Procedure
To start measurements and retrieve measurement data, the communication
mode must be set to On-Line and the measurement mode must be set to
Harmonic Measurement.

Starting Measurements
From the Measure menu, choose Start.  The retrieval of the harmonic
measurement data measured on the WT starts.  The retrieved measurement
data is displayed in the Acquisition data window (see the explanation given

later).  You can also click  on the toolbar.

Stopping Measurements
• Automatically Stopping Measurements

When the specified measurement time elapses, measurements automatically

stop.

• Aborting Measurements
From the Measure menu, choose Stop.  If the WT is in the middle of
measurement, measurement stops after the measurement correctly ends and
the retrieval of waveform data is finished.  You can also click  on the toolbar.

Explanation
Starting/Stopping Measurements

When in On-Line mode, measurement can be started.  Measurement cannot be
started in Off-Line mode.  When measurement is started in Harmonic Measurement

mode, the retrieval of the harmonic measurement data measured on the WT starts.
When the specified measurement time elapses, measurement is automatically
stopped.  You can also abort the measurement before the specified measurement

time elapses.  The waveform data is retrieved immediately after the measurement
stops.  For a description of the function used to display the measured data and
evaluation results, see chapter 4.

Note
When measurement is started in Harmonic Monitor or Waveform Monitor mode, the retrieval

of the harmonic measurement data or waveform data measured on the WT starts.  These

modes are used to monitor the conditions of the harmonics and waveforms and do not

evaluate against the standard as in Harmonic Measurement Mode.  To stop the measurement

and data retrieval in these modes, click Stop.  For details, see chapter 5.
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Displayed Contents of the Acquisition (Measurement) Data Window

Measurement (acquisition) data number
The measured data of harmonics per 16 cycles of the fundamental frequency is one set of harmonic 
measurement data (instantaneous values).  The software retrieves this data and displays the data as 
measured data.  This example indicates that 472 sets of data have been retrieved and the first measured 
data is being displayed.

Meas Time
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.32 s) when the first measured data was retrieved.

Scroll bar
Drag the     (slider) or click           to select the measured data 
you wish to display.  The Meas Time and the Sample Count 
number change in sync with the slider position.

Up/Down button
Click to select the displayed measured data one by one.  The 
Meas Time, Sample Count number, and the slider position 
change in sync each time the Up/Down button is clicked.

Harmonic orders (orders 1 to 40)

Voltage value of each order (rms value)

Current value of each order (rms value)

Fundamental frequency of the PLL source

Active power
Sum of all the active powers of orders 1 to 40

Harmonic distortion factor of voltage
Ratio of the total harmonic voltage with respect to the 
fundamental voltage

Harmonic distortion factor of current
Ratio of the total harmonic current with respect to the 
fundamental current

Total harmonic current
Sum of harmonic currents of orders 2 to 40 (rms value)

Sum of odd harmonic currents of order above and 
including 21
This example indicates the value of the first measured data

Sum of odd harmonic currents of order above and 
including 21 (maximum value)
This example displays the maximum value among the 472 
sets of measured data.

Time elapsed since the start of 
measurement (displayed during 
measurement)

Indicates Online or Offline

Phase angle of the current of each order with respect to the fundamental current
However, the phase angle displayed on the 1st order line (9.974° in this example) is 
the phase angle of the fundamental current with respect to the fundamental voltage.

WT input element
The displayed input 
elements vary depending 
on the wiring system 
configuration of the WT.

Preset measurement timeModel of WT Under Operation

3.8  Starting and Stopping Measurements (Retrieving Measured Data/Waveform Data)
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3.9 Switching to Off-Line Mode (Switching from
On-Line Mode to Off-Line Mode)

Procedure
From the Communications menu, choose Off-Line.  Communications with the
target digital power meter is disconnected and a message “Communication with

GPIB was ended” appears.

On the status bar of the window, check that Offline is indicated.

Offline

Explanation
When the communication mode is changed from On-Line to Off-Line, communications

with the target digital power meter is disconnected.  You can also make evaluations
according to the IEC standard (see section 1.3) by loading measured data already saved
to a file in Off-Line mode.  For a description of the function used to display the evaluation

results and measured data, see chapter 4.

Note
To change the communication mode from Off-Line back to On-Line, follow the procedures

given in sections 3.1, 3.2 and 3.3.
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3.10 Loading Setup Information, Measured Data,
and Waveform Data

Procedure
Note

• Setup information, measured data, and waveform data cannot be loaded when the

measurement mode is set to Harmonic Monitor or Waveform Monitor.

• If an error occurs while loading the setup information, the settings are reset to thier default values.

• If an error occurs while loading setup information, measured data, or waveform data, the data

may not be loaded properly.  Check the file name and extension, and load the data again.

• Setup information, measured data, and waveform data cannot be loaded while measurement

is in progress.

Loading Setup Information
1. From the File menu, point to Load then choose Load Setup Information.  The

Open dialog box opens.  You can also select Load Setup Information from the

Load icon on the toolbar.

2. Select a file name and click Open.  The setup information of the selected file is
loaded.

Loading Measured Data, Waveform Data, and Setup Information
Measured data, waveform data, and setup information can be loaded when the
measurement mode is set to Harmonic Measurement.

1. From the File menu, point to Load then choose Load Measured Data.  The
Open dialog box opens.  You can also select Load Measured Data from the
Load icon on the toolbar.
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2. Select a file name and click Open.  The measured data, waveform data, or
setup information of the selected file is loaded.

Explanation
Loading Setup Information

The setup information saved in section 6.1 can be loaded.

• The extension of the loaded file is .cfg.
• The details of the setup information are as follows.

• Measurement mode (see section 3.5).

• Standard and measurement environment settings (see section 3.6).
The measurement data retrieved from the WT or loaded from a file can be
evaluated using the loaded evaluation conditions.

• Measurement time (see section 3.7).
• Display settings (chapters 4 and 5).
• Title/Comment of Reports (see section 7.2).

Reports of measurement data retrieved from the WT or loaded from a file can be
saved or printed by attaching the loaded title or comment.  For the saving and
printing procedure, see chapter 7.

Loading Measured Data, Waveform Data, and Setup Information
• The measurement data, waveform data, and setup information saved in section 6.1

can be loaded.

• Measured data can be loaded when the measurement mode is set to Harmonic
Measurement.

• When one of the files with .bt1, .bt2, .bt3, and .bt4 extension is selected in the

Open dialog box and loaded, the data of all the files with the same file name in the
same directory is loaded.  See the following table.

Data Type Extension

WT2000 Measured data of input element 1 .bt1

Measured data of input element 2 .bt2

Measured data of input element 3 .bt3

Measured data common to all input elements .bt4

Waveform data of input element 1 .bw1

Waveform data of input element 2 .bw2

Waveform data of input element 3 .bw3

3.10  Loading Setup Information, Measured Data, and Waveform Data
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Data Type Extension

WT1600* Measured data on the left side of the acquisition data window .bt1

Measured data in the center of the acquisition data window .bt2

Measured data on the right of the acquisition data window .bt3

Measured data common to all input elements .bt4

Waveform data on the left side of the acquisition data window .bw1

Waveform data in the center of the acquisition data window .bw2

Waveform data on the right side of the acquisition data window .bw3

Harmonic measurement conditions of the WT .inf
• If the communication mode is On-Line, the harmonic measurement conditions of the loaded

file are applied to “WT Setting” (chapter 8) of the software and transmitted to the WT.  If the
transmitted harmonic measurement conditions do not match the configuration of the WT, an
error message appears.  Check the configuration of the connected WT.

• If the communication mode is Off-Line, the harmonic measurement conditions of the loaded file are
applied to “WT Setting” of the software, but not transmitted to the WT.  If the mode is switched from
Off-Line to On-Line, the harmonic measurement conditions is loaded from the WT into the software.

Setup information of specifications, evaluation, etc. .cfg
Same data as those described in “Setup Information” above.

* : For WT1600

Left side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt1
Waveform data .bw1

Center of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt2
Waveform data .bw2

Right side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt3
Waveform data .bw3

3.10  Loading Setup Information, Measured Data, and Waveform Data
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Chapter 4 Displaying the Evaluation Results and Measured Data/Waveform Data

4.1 Displaying the Evaluation Results over the
Entire Measurement Time

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.  Below a procedure
is given in which the wiring system of the WT2000 is set to single-phase two-wire (1P2W

or 1φ2W, indication on the front panel varies depending on the model) and one input
element is used.

1. From the View menu, point to Overall Evaluation Graph then choose
Element1.  The Overall Evaluation Graph (Element 1) window opens.  You can
also choose View > Overall Evaluation Graph > Element1 from the toolbar.

2. Use the scroll bar to set the time zone to be displayed.  The evaluation graph of

the specified time zone is displayed.

Evaluation graph
Of the measured date, the evaluation results over the time span of 150 s are 
displayed.  The bars of each order are displayed using different colors depending 
on the result.  If you change the time zone to be displayed using the display range 
bar, the time zone displayed on the evaluation graph changes accordingly.  The 
time span of the evaluation graph, 150 s, does not change.

Display range bar
Displays the position of the time zone specified with the scroll bar with respect to 
the measurement time.

Scroll bar
Drag the     (slider) or click           to select the time zone you wish to display.  The time 
zone of the evaluation graph changes in sync with the slider position.  Active when the 
measurement time is greater than 150 s.
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Explanation
Evaluation can be made as to whether all of the harmonic measurement data in the
measurement time are within the limits according to the settings specified in section 3.6
“Setting the Standard and Measurement Environment,” and the results can be displayed

collectively.

The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation
of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.

• Overall Evaluation Graph Window

Evaluation graph
Of the measured data, the evaluation results over the time span of 150 s (2.5 
minutes) are displayed.  The bars of each order are displayed using different colors 
depending on the result.  If you change the time zone to be displayed using the 
display range bar, the time zone displayed on the evaluation graph changes 
accordingly.  The time span of the evaluation graph, 150 s, does not change.

Display range bar
Displays the position of the time zone specified with the scroll bar with respect to 
the measurement time.

Scroll bar
Drag the     (slider) or click           to select the time zone you wish to display.  The time 
zone of the evaluation graph changes in sync with the slider position.  Active when the 
measurement time is greater than 150 s.

Number of the input element being 
displayed
In this example, input element 1 is 
being evaluated.

Applicable standard
This software can make evaluations 
according to the IEC standard.

Class
Indicates the class of equipment as 
specified by the applicable standard.

Judgment
If evaluation of all the data points 
over the measurement time is blue, 
bright green, turquoise, or aqua as 
described on the next page, PASS is 
indicated.  If the evaluation of any 
data point is yellow, orange, pink, or 
red, FAIL is indicated.

Fundamental frequency of the PLL 
source (average)
Displays the average fundamental 
frequency of the PLL source of the 
measured data.

Cursor
Click a point within the evaluation graph to 
move the cursor to the data position (time).

Measurement time (setting value)

Measurement timeTime zone of the evaluation graph

4.1  Displaying the Evaluation Results over the Entire Measurement Time
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Evaluation Colors
The meaning of the evaluation colors indicated in the evaluation graph is shown in the

following table.  Below are the conditions of Condition 1, Condition 2, and Relaxation
Condition.

• Condition 1
The maximum harmonic current over the measurement time is within 1.5 times the
specified limit.  Evaluation is made on each order.

• Condition 2
The mean harmonic current over the measurement time is within the specified limit.

Evaluation is made on each order.

• Relaxation Condition
If the maximum value of the sum of partial odd harmonic currents (POHC) of order
above and including 21 is less than the specified POHC limit, the mean of the odd
harmonic currents of order above and including 21 is permitted to be 1.5 times the

specified limit.

Blue
Both Conditions 1 and 2 are met.  Or, no applicable limits are specified.
(If no applicable limits are specified, white is displayed only for the bar graph display
described in section 4.2.)

Bright green
• Condition 1 is met.
• Condition 2 is not met.
• Relaxation Condition is met.

Yellow
• Condition 1 is met.
• Condition 2 is not met.
• Relaxation Condition is not met.

Orange
• Condition 1 is not met.
• Condition 2 is met.

Pink
• Condition 1 is not met.
• Condition 2 is not met.
• Relaxation Condition is met.

Red
None of Condition 1, 2, and Relaxation Condition is met.

Turquoise
The measured data is less than the larger of the two values, 0.6% of the mean rms current
and 5 mA.

Aqua
• None of Condition 1, 2, and Relaxation Condition is met.
• Excluded from applying the limits because the maximum active power is less than the

minimum power (75 W or 50 W) for applying the limits.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
evaluation colors.

If the evaluation of all the data points over the measurement time is blue, bright green,

turquoise, or aqua, Judgment on the Overall Evaluation Graph window indicates
PASS.  If the evaluation of any data point is yellow, orange, pink, or red, Judgment
indicates FAIL.

4.1  Displaying the Evaluation Results over the Entire Measurement Time
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Convenient Way of Using the Overall Evaluation Graph
You can select a section of the measured data of interest on the Overall Evaluation

Graph and display the instantaneous values on a bar graph or in a list.  Below is an
example for displaying a bar graph of the harmonic current of input element 1.

1. On the Overall Evaluation Graph, click the section of interest using the mouse.
The cursor moves to the data position (time) that was clicked.

The cursor moves to the position (time) 
where the mouse is pointed and clicked.

Cursor

Displays the cursor
position (time)

2. From the menu, choose View > Harmonic Current Bar Graph > Instant Value
> Element1.  The instantaneous values of the harmonic currents at the cursor
position (time) are displayed on a bar graph.

For a detailed description of the bar graph, see section 4.2.

Displays the time corresponding to the cursor position (time)

The section where the level of the harmonic component of order 4 differs
and the Judgment changes from blue to turquoise

4.1  Displaying the Evaluation Results over the Entire Measurement Time
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4.2 Displaying the Bar Graph of Harmonic Current/
Voltage

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.  Below a procedure
is given in which the wiring system of the WT2000 is set to single-phase two-wire (1P2W

or 1φ2W, indication on the front panel varies depending on the model) and one input
element is used.

Displaying the Bar Graph of Harmonic Current
From the View menu, point to Harmonic Current Bar Graph then point to
Maximum, Average Value, or Instant Value, and then choose Element1.  The

Harmonic Current Bar Graph (Element 1) window opens.  You can also select
View > Harmonic Current Bar Graph > Maximum, Average Value, or Instant
Value > Element1 from the toolbar.

Display Example: Harmonic Current Instant Bar Graph (Element 1)
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Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.

When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

• Enabling Percentage Display
Select the Percentage Display check box.  Y-axis scale, THC, POHC, POHC
maximum and POHC limit are displayed in percentages.  The relative harmonic

content of current of each order can be displayed on bar graphs with the
specified fundamental current (fundamental current specified in advance when
making Class C evaluation, see section 3.6) taken to be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

Displaying the Limits
Select the Limit Value check box.  The limits specified in the applicable
standard are displayed using yellow bars for each order.

Displays the limits using yellow bars

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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Selecting the Instantaneous Values
On the Harmonic Current Instant Bar Graph window, use the scroll bar to select

the instantaneous value to be displayed.

Scroll bar
Drag the     (slider) or click           to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Displaying the Bar Graph of Harmonic Voltage
From the View menu, point to Harmonic Voltage Bar Graph then point to

Maximum, Average Value, or Instant Value, and then choose Element1.  The
Harmonic Voltage Bar Graph (Element 1) window opens.  You can also select
View > Harmonic Voltage Bar Graph > Maximum, Average Value, or Instant
Value > Element1 from the toolbar.

The operations on the Harmonic Voltage Bar Graph window are the same as the

operations on the Harmonic Current Bar Graph window.  However, because the
voltage does not need to be compared and evaluated against the limit,
operations for percentage display and limit display are not present.  Judgment is

not displayed.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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Explanation
Evaluation can be made as to whether all of the harmonic data in the measurement time
are within the limits according to the settings specified in section 3.6 “Setting the
Standard and Measurement Environment,” and the results can be displayed on bar
graphs.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation
of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.

Here, explanation is given for the bar graph of harmonic current.  In the case of the bar
graph of harmonic voltage, read “harmonic current” as “harmonic voltage” in the following
explanation.  However, because the voltage does not need to be compared and
evaluated against the limit, the explanation of percentage display and limit display are
not applicable.

Harmonic Current Bar Graph Window

Scroll bar (not displayed for maximum and average.)
Drag the     (slider) or click          to select the instantaneous value 
you wish to display.  Meas Time changes in sync with the slider 

Meas Time (not displayed for maximum and average.)
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.32 s) when the first measured data was retrieved.

Window title
The title is "Harmonic Current Maximum Bar Graph" when the window displays the 
maximum values of the harmonic current, "Harmonic Current Average Bar Graph" 
when the window displays the averages, and "Harmonic Current Instant Bar Graph" 
when the instantaneous values.

Displays the limits using yellow bars

Select the Y-axis scale

• Element
Number of the input element being displayed.  In this example, input element 1 is being displayed.

• Standard
Applicable standard.  This software can make evaluations according to the IEC standard.

• Class
Class of equipment under evaluation Indicates the class of equipment as specified by the
applicable standard.

• Judgment
If evaluation of all the data points over the measurement time is blue, bright green, turquoise,
or aqua as described on page 4-3, PASS is indicated.  If the evaluation of any data point is
yellow, orange, pink, or red, FAIL is indicated.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• Range

Measurement range selected in the WT configuration (see chapter 8).

• Frequency

Fundamental frequency of the PLL source.

• In the case of the Harmonic Current Maximum Bar Graph (or list), the frequency at which

the harmonic current measurement data is maximum within the measurement time

(fundamental frequency of the PLL source) is indicated.

• In the case of the Harmonic Current Average Bar Graph (or list), the average value of all

frequencies (fundamental frequency of the PLL source) within the measurement time is indicated.

• In the case of the Harmonic Current Instant Bar Graph (or list), the frequency of the

individual measurement data point within the measurement time (fundamental frequency

of the PLL source) is indicated.

• Voltage (rms)

k = 1

40

U(k)2

U(k): rms voltage of each order, k: harmonic order

• Current (rms)

k = 1

40

I(k)2

I(k): rms current of each order, k: harmonic order

• Power P

k = 1

40

P(k)

P(k): active power of each order, k: harmonic order

• Power S

Voltage (rms) × current (rms)

• PF

× 100
Active power

Apparent power
For multi-phase equipment, the power factor is derived from the active power and

apparent power of all phases.  The computing equation of the active power and apparent

power of all phases varies depending on the wiring system (see the next page).

• V THD

k = 2

40

U(k)2

U(1)
× 100

U(k): rms voltage of each order, k: harmonic order, U(1): rms voltage of the

fundamental signal

• A THD

k = 2

40

I(k)2

I(1)
× 100

I(K): rms current of each order, k: harmonic order, I(1): rms current of the fundamental signal

• THC

k = 2

40

I(k)2

I(k): rms current of each order, k: harmonic order

• POHC

Displayed on Instant Bar Graph (or list).

k = 21, 23

39

I(k)2

I(k): rms current of odd harmonics above and including order 21, k: harmonic order,

odd value above and including 21

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• POHC Max

Displayed on Maximum and Average Bar Graphs (or lists).  POHC maximum derived from

individual measured data points within the measurement time.  If this value is less than the

POHC Limit, the relaxation condition (see page 4-3) is applied.

• POHC Limit

k = 21, 23

39

IL(k)2

IL(k): Limits of even harmonics above and including 21 as specified by the applicable

standard

k: harmonic order, odd value above and including 21

• Sigma W

The computing equation of the active power of all phases, Sigma W, varies depending on the

wiring system.

WT2000

Wiring System Sigma W Equation Apparent Power of All Phases

1P2W (1φ2W) Active power of each input element Apparent power of each input element

1P3W (1φ3W) W1+W3 VA1+VA3

3P3W(3φ3W) W1+W3 (VA1+VA3) ×  3/2

3V3A W1+W3 (VA1+VA2+VA3)×  3/3

3P4W(3φ4W) W1+W2+W3 VA1+VA2+VA3

* W1, W2, and W3 are active powers of input elements 1, 2, and 3, respectively (see the active
power section on the previous page).  VA1, VA2, and VA3 are apparent powers of input
elements 1, 2, and 3, respectively.

WT1600

Wiring System Sigma W Equation Apparent Power of All Phases

1P2W Active power of each input element Apparent power of each input element

1P3W W1+W2 VA1+VA2

3P3W W1+W2 (VA1+VA2) ×  3/2

3V3A W1+W2 (VA1+VA2+VA3)×  3/3

3P4W W1+W2+W3 VA1+VA2+VA3

* W1, W2, and W3 are the active power values displayed in the corresponding position in the
acquisition data window.  VA1, VA2, and VA3 are the apparent power values displayed in the
corresponding position in the acquisition data window.

Note
• When applying the power ratio limit on Class C or D multi-phase equipment, the harmonic

current per watt derived from the total active power (Sigma W) of all phases (three phases if

three-phase) and the power ratio limit are compared and evaluated.

• Equipment whose Sigma W exceeds 600 W is considered Class A equipment under the

standard.  Use caution because the software makes evaluations using the class selected in

standard and measurement environment settings (see section 3.6).

• Set P, Set Fund I, and Set PF

For Set P, the power value (see section 3.6) specified in advance is displayed when making

Class C or D evaluations.

For Set Fund I and Set PF, the fundamental current and power factor values (see section 3.6)

specified in advance are displayed respectively when making Class C evaluations.

Note
If the Percentage Display check box is selected, the Y-axis scale, THC, POHC, POHC

maximum and POHC limit are displayed in percentages.

Displaying the Limits
• If the Limit Value check box is selected, the limits specified in the applicable

standard are displayed using yellow bars for each order.
• The limits are applied only to harmonic current.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• When limits are specified by the relative harmonic content of order 3 and 5 such as
the limits for Class C equipment with active input power less than or equal to 25 W,

bars of magnitude corresponding to the current values converted from the relative
harmonic content of order 3 and 5 with the fundamental current specified in
advance (see section 3.6) taken to be 100% are displayed.

Bar Graph Type and Displayed Contents
Three types of harmonic current bar graphs are available: maximum bar graph,
average bar graph, and instantaneous bar graph.  The meanings of the displayed

items which vary depending on the bar graph are explained below.
• Items Displayed on the Maximum Bar Graph

• Bar displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement are compared, and the maximum value is displayed.

• Items displayed at the bottom section of the bar graph

The items described on pages 4-8 and 4-10 are displayed.
For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are compared, and the

maximum value is displayed.
• Limit bar

Yellow bars that are 1.5 times the magnitude of the limits specified by the

applicable standard are displayed.
• Items Displayed on the Average Bar Graph

• Bar displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement are averaged, and the average value is displayed.

• Measurement items displayed at the bottom section of the bar graph

The items described on pages 4-8 and 4-10 are displayed.
For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are averaged, and the average

value is displayed.
• Limit bar

Yellow bars that correspond to the magnitude of the limits specified by the

applicable standard are displayed.
• Items Displayed on the Instantaneous Bar Graph

• Bar displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement time are displayed.

• Measurement items displayed at the bottom section of the bar graph

The items described on pages 4-8 and 4-10 are displayed.
Values derived from individual measured data points within the measurement
time are displayed.

• Limit bar
Yellow bars that are 1.5 times the magnitude of the limits specified by the
applicable standard are displayed.

• Instantaneous values
You can use the scroll bar to select the instantaneous values to be displayed.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).
• Selecting the Magnification

When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.
When the type of scale is LOG, you can select *100.0, *10.0, *1.0, or *0.1.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the
measurement range selected in the WT configuration (see chapter 8).  The

maximum value of the LOG scale is one digit above the measurement range,
value that is 10 to an integer power.

• If Auto range is selected in the WT configuration, the maximum value of the LIN or LOG

scale is determined using the same principle described above using the measurement
range of the WT that was used when measurement was made as a reference.

• Percentage Display
If the Percentage Display check box is selected, the Y-axis scale, THC, POHC,
POHC maximum and POHC limit can be displayed in percentages.  The relative
harmonic content of current of each order can be displayed on bar graphs with the

specified fundamental current (fundamental current specified in advance when
making Class C evaluation, see section 3.6) taken to be 100%.
• When the magnification of the Y-axis scale is *1.0, the maximum scale of Y-axis

is 100.00%.
• The Percentage Display check box becomes selectable under given conditions.

The Percentage Display check box becomes selectable when the EUT is of

Class C, and ratios are used to evaluate the limits (see section 1.3).
• The percentage display is applied only to harmonic current.
• When limits are specified by the relative harmonic content of order 3 and 5 such

as the limits for Class C equipment with active input power less than or equal to
25 W, bars corresponding to the magnitude of the values are displayed.

Color of Bars
The bar graph that is displayed for each order is displayed using a length converted
from the magnitude of the measured data.  The meaning of the colors is indicated in
the following table.

Blue
Limit not exceeded.

Bright green (applies only to average bar graph)
When the same conditions of bright green on page 4-3 applies.

Red
Limit exceeded.

White
No applicable limit is specified.
(The bar graph of the fundamental frequency and orders that are not applicable is displayed
in white.)

Yellow
Limit specified by the applicable standard.

Turquoise
The measured data is less than the larger of the two values, 0.6% of the mean rms current
and 5 mA.

Aqua
• Limit exceeded.
• Excluded from applying the limits because the maximum active power is less than the

minimum power (75 W or 50 W) for applying the limits.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

Bar graphs of harmonic voltage are displayed in white.  Harmonic voltage does not
need to be compared and evaluated against the limit.

Mutual Relationship of Graphs and Lists
When using the scroll bar to select the time of acquisition and displaying the measured data
on a graph window or list window displaying a certain instantaneous value, the other graph

window or list window also shows the measured data at the same time of acquisition.

4.2  Displaying the Bar Graph of Harmonic Current/Voltage
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4.3 Displaying the List of Harmonic Current/
Voltage

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.  Below a procedure
is given in which the wiring system of the WT2000 is set to single-phase two-wire (1P2W

or 1φ2W, indication on the front panel varies depending on the model) and one input
element is used.

Displaying the List of Harmonic Current
From the View menu, point to Harmonic Current Measure Value List then
point to Maximum, Average Value, or Instant Value, and then choose

Element1.  The Harmonic Current List (Element 1) window opens.  You can
also select View > Harmonic Current Measure Value List > Maximum,
Average Value, or Instant Value > Element1 from the toolbar.

Display Example: Harmonic Current Instant Value List (Element 1)
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Enabling Percentage Display
Select the Percentage Display check box.  Measured value, limit, THC, POHC,

POHC maximum and POHC limit are displayed in percentages.  The relative
harmonic content of current of each order can be displayed in the Measure and
Limit columns with the specified fundamental current (fundamental current

specified in advance when making Class C evaluation, see section 3.6) taken to
be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

Selecting the Instantaneous Value
On the Harmonic Current Measure Value List window, you can use the scroll bar
to select the instantaneous values to be displayed.

Scroll bar
Drag the     (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

4.3  Displaying the List of Harmonic Current/Voltage
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Displaying the List of Harmonic Voltage
From the View menu, point to Harmonic Voltage Measure Value List then

point to Maximum, Average Value, or Instant Value, and then choose
Element1.  The Harmonic Voltage List (Element 1) window opens.  You can
also select View > Harmonic Voltage Measure Value List > Maximum,

Average Value, or Instant Value > Element1 from the toolbar.

The operations on the Harmonic Voltage List window are the same as the

operations on the Harmonic Current List window.  However, because the
voltage does not need to be compared and evaluated against the limit,
operations for percentage display are not present.  Judgment, limit, and margin

are not displayed.

4.3  Displaying the List of Harmonic Current/Voltage
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Explanation
Evaluation can be made as to whether all of the harmonic data in the measurement time
are within the limits according to the settings specified in section 3.6 “Setting the
Standard and Measurement Environment,” and the results can be displayed in a list.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The evaluation

of whether the results are within the limits of the applicable standard are made by
considering all the input elements specified in the WT wiring system.

Here, explanation is given for the list of harmonic current.  In the case of the list of

harmonic voltage, read “harmonic current” as “harmonic voltage” in the following
explanation.  However, because the voltage does not need to be compared and
evaluated against the limit, the explanation of judgment, percentage display, limit, and

margin are not applicable.

Harmonic Current List Window

Scroll bar (not displayed for maximum and average.)
Drag the     (slider) or click          to select the instantaneous value 
you wish to display.  Meas Time changes in sync with the slider 
position.

Meas Time (not displayed for maximum and average.)
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.32 s) when the first measured data was retrieved.

Window title
The title is "Harmonic Current Maximum List" when the window displays the 
maximum values of the harmonic current, "Harmonic Current Average List" when the 
window displays the averages, and "Harmonic Current Instant List" when the 
instantaneous values.

For a description of the items from Element to Set PF in the list window, see the
explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage”
(page 4-8).

4.3  Displaying the List of Harmonic Current/Voltage
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Limit
• The limits specified in the applicable standard are displayed in a list for each order.

• The limits are applied only to harmonic current.
• If the Percentage Display check box is selected, the relative harmonic content of

the limit of each order can be displayed with the specified fundamental current

(fundamental current specified in advance when making Class C evaluation, see
section 3.6) taken to be 100%.

• When limits are specified by the relative harmonic content of order 3 and 5 such as

the limits for Class C equipment with active input power less than or equal to 25 W,
the current value converted from the relative harmonic content of order 3 and 5
with the fundamental current specified in advance (see section 3.6) taken to be

100% is displayed.

Margin
Indicates the margin to the limit.  For each order, the margin is derived from the
following equation using the limits and measured values displayed in the list.

× 100
Limit – measured value

Limit

List Type and Displayed Contents
Three types of harmonic current lists are available: maximum list, average list, and

instantaneous list.  The meanings of the displayed items which vary depending on the
list are explained below.

• Items Displayed on the Maximum List
• Measured value displayed for each order

For each order, the individual measured data points (instantaneous values)

within the measurement are compared, and the maximum value is displayed.
• Items displayed in the right column of the list

The items described on pages 4-8 and 4-10 are displayed.

For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are compared, and the
maximum value is displayed.

• Limit
Indicates values that are 1.5 times the limits specified by the applicable
standard.

• Items Displayed on the Average List
• Measured value displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement are averaged, and the average value is displayed.

• Items displayed in the right column of the list

The items described on pages 4-8 and 4-10 are displayed.
For each item, the values derived from individual measured data points
(instantaneous values) within the measurement are averaged, and the average

value is displayed.
• Limit

Indicates the limits specified by the applicable standard.

4.3  Displaying the List of Harmonic Current/Voltage
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• Items Displayed on the Instantaneous List
• Measured value displayed for each order

For each order, the individual measured data points (instantaneous values)
within the measurement time are displayed.

• Items displayed in the right column of the list

The items described on pages 4-8 and 4-10 are displayed.
Values derived from individual measured data points within the measurement
time are displayed.

• Limit
Indicates values that are 1.5 times the limits specified by the applicable standard.

• Instantaneous values

You can use the scroll bar to select the instantaneous values to be displayed.

Percentage Display
If the Percentage Display check box is selected, the THC, POHC, POHC maximum

and POHC limit can be displayed in percentages.  The relative harmonic content of
the measured value or limit of each order can be displayed with the specified
fundamental current (fundamental current specified in advance when making Class C

evaluation, see section 3.6) taken to be 100%.
• The Percentage Display check box becomes selectable under given conditions.

The Percentage Display check box becomes selectable when the EUT is of Class

C, and ratios are used to evaluate the limits (see section 1.3).
• The percentage display is applied only to harmonic current.
• When limits are specified by the relative harmonic content of order 3 and 5 such as

the limits for Class C equipment with active input power less than or equal to 25 W,
the values are displayed.

Color of Measured Values
The meaning of the colors of the measured values displayed for each order is
indicated in the following table.

Blue
Limit not exceeded.

Bright green (applies only to average list)
When the same conditions of bright green on page 4-3 applies.

Red
Limit exceeded.

Black
No applicable limit is specified.
(The measured value of the fundamental frequency and orders that are not applicable is
displayed in black.)

Turquoise
The measured data is less than the larger of the two values, 0.6% of the mean rms current and 5 mA.

Aqua
• Limit exceeded.
• Excluded from applying the limits because the maximum active power is less than the

minimum power (75 W or 50 W) for applying the limits.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

The measured value of harmonic voltage are displayed in black.  Harmonic voltage

does not need to be compared and evaluated against the limit.

Mutual Relationship of Graphs and Lists
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/

Voltage” (page 4-12).

4.3  Displaying the List of Harmonic Current/Voltage
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4.4 Displaying the Bar Graph of the Harmonic
Current Fluctuation

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and
one input element is used.

Displaying the Harmonic Current Change Graph Window
From the View menu, point to Harmonic Current Fluctuation Graph then

choose Element1.  The Harmonic Current Fluctuation Graph (Element 1)
window opens.  You can also choose View > Harmonic Current Fluctuation
Graph > Element1 from the toolbar.

Display Example: Harmonic Current Fluctuation Graph (Element 1)

Selecting the Order of Current to Be Displayed
From the order selection box, select a value from 1 to 40 or THC.

The maximum number of graph lines that can be displayed is 6.

Order selection box
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Showing/Hiding the Graph
Use the show/hide check box to select whether to show or hide the graph.

Show/Hide check box

Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.

When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

• Enabling Percentage Display
Select the Percentage Display check box.  The Y-axis scale is displayed in
percentages.  The relative harmonic content of current of each order can be

displayed on graphs with the specified fundamental current (fundamental current
specified in advance when making Class C evaluation, see section 3.6) taken to
be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

4.4  Displaying the Bar Graph of the Harmonic Current Fluctuation
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Selecting the Time Zone
Use the scroll bar to set the time zone to be displayed.  The harmonic current

fluctuation graph of the specified time zone is displayed.

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

The left end position (time) corresponds to the cursor position (time, 
see page 4-4) of the Overall Evaluation Graph.

Explanation
The harmonic current fluctuation over time can be displayed on graphs.
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The bar graph

can be displayed for each input element of the WT.

Harmonic Current Fluctuation Graph Window

Scroll bar
Drag the     (slider) or click          to select the time zone 
you wish to display.  The time zone of the graph changes in 
sync with the slider position.

Select the Y-axis
scale

Show/Hide check box

Order selection box

4.4  Displaying the Bar Graph of the Harmonic Current Fluctuation
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Selecting the Order
The maximum number of graph lines that can be displayed is 6.  For each graph, you

can select which order of harmonic current to be displayed.
Selectable range: 1 to 40 or THC

Selecting Show/Hide
You can select whether to show or hide each graph.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or

*0.1.
When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.
• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the

measurement range selected in the WT configuration (see chapter 8).  The
maximum value of the LOG scale is one digit above the measurement range,
and is a value that is an integer power of 10.

• If Auto range is selected in the WT configuration, the maximum value of the LIN
or LOG scale is determined based on the same principle described above using
the measurement range of the WT that was used when measurement was made

as a reference.

• Percentage Display
If you select the Percentage Display check box, the Y-axis scale can be displayed
in percentages.  The change in the relative harmonic content of current of each
order can be displayed on graphs with the specified fundamental current

(fundamental current specified in advance when making Class C evaluation, see
section 3.6) taken to be 100%.
• When the magnification of the Y-axis scale is *1.0, the maximum scale of Y-axis

is 100.00%.
• The Percentage Display check box becomes selectable under given conditions.

The Percentage Display check box becomes selectable when the EUT is of

Class C, and ratios are used to evaluate the limits (see section 1.3).

Color
The colors of the 6 graphs are as follows:

 White,  turquoise,  blue,  bright green,  yellow, and  red.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

Mutual Relationship between the Harmonic Current Change Graph and Measured
Value Judging Graph (see section 4.1)

The left end position (time) of the Harmonic Current Change Graph corresponds to
the cursor position (time, see page 4-4) of the Measured Value Judging Graph.  If you

move the cursor on the Measured Value Judging Graph, the time at the cursor
position becomes the time at the left end of the Harmonic Current Change Graph.

4.4  Displaying the Bar Graph of the Harmonic Current Fluctuation
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4.5 Displaying the Voltage/Current Waveforms

Procedure
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  Below a
procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and

one input element is used.
The waveform data retrieved immediately before the measurement was stopped in
Harmonic Measurement Mode (see section 3.5) is displayed as voltage or current

waveform on the waveform graph.

Displaying Waveforms
From the View menu, point to Wave Graph then choose Element1.  The
Waveform Graph (Element 1) window opens.  You can also choose View >
Wave Graph > Element1 from the toolbar.

Display Example: Wave Graph (Element 1)

Showing/Hiding Waveforms
Use the show/hide check box to select whether to show or hide the waveform.
The selection can be made for the voltage and current individually.

Show/Hide check box
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Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
Select a value from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and*0.1.

Displaying the Current Value and Phase Angle Using the Cursor
Drag the slider with the mouse to move the cursor.  The current value and
phase angle at the new cursor position are displayed.

The phase angle is the phase difference with respect to the first zero crossing of the

voltage waveform as 0 degrees within the waveform display area.

Slider CursorPhase angle

Current value

Explanation
The waveform data retrieved immediately before the measurement was stopped in
Harmonic Measurement Mode (see section 3.5) is displayed as voltage or current
waveform on the waveform graph.  The bar graph can be displayed for each input

element of the WT.  The data is also different from the data displayed in Harmonic
Monitor or Waveform Monitor Mode.  When evaluating Class C equipment with active
input power less than or equal to 25 W using the limits of the harmonics of order 3 and 5,

view the waveform data here and check whether the relationship of the voltage and
current waveforms is within the limits.

Waveform Graph

Slider CursorPhase angle

Current value

First zero crossing point of the voltage waveform

Voltage waveform

Current waveform

Indicates the position of the phase angles of 60, 65, and 90 degrees, which are used in 
the evaluation of Class C equipment with active input power less than or equal to 25 W.

Select the magnification of the Y-axis scale

4.5  Displaying the Voltage/Current Waveforms
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• Element

Number of the input element under evaluation.  In this example, input element 1 is being

displayed.

• Range

Measurement range selected in the WT configuration (see chapter 8).

• Class

Class of the applicable standard.

• Frequency

The average value of all frequencies (frequency of the fundamental signal of the PLL source)

within the measurement time.

• Current Peak (+)

Maximum positive value of the current waveform displayed.

• Current Peak (–)

Maximum negative value of the current waveform displayed.

• Voltage Peak (+)

Maximum positive value of the voltage waveform displayed.

• Voltage Peak (–)

Maximum negative value of the voltage waveform displayed.

Selecting Show/Hide
You can select whether to show or hide the voltage and current individually.

Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
• The scale type is fixed to LIN (linear).  LOG (logarithmic) scale is not supported.

• You can select the magnification from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and *0.1.

Displaying the Current Value and Phase Angle Using the Cursor
When evaluating Class C equipment with active input power less than or equal to 25
W using the limits of the harmonics of order 3 and 5, you can check whether the
relationship of the voltage and current waveforms is within the limits.

• You can display the current value and phase angle at the new cursor position.
• The phase angle is the phase difference with respect to the first zero crossing of

the voltage waveform (0 degrees) within the waveform display area.

• Fixed vertical lines are displayed at the phase angles 60, 65, and 90 degrees used
in the evaluation.  You can check the evaluation conditions (see section 1.3) by
viewing the fixed lines and the current waveform.

Note
If the PLL frequency differs from the voltage frequency being displayed, for the element, the

display may be incorrect since the phase angle value is displayed according to the PLL

frequency.  Measurements should be taken only when the PLL frequency and voltage

frequency are the same.

4.5  Displaying the Voltage/Current Waveforms
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4.6 Displaying the Graph of Voltage, Current, and
Power

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and
one input element is used.

Displaying the Voltage, Current, and Power Fluctuation Graph
From the View menu, point to Voltage, Current, and Electric Power
Fluctuation Graph, and then choose Element1.  The Voltage, Current, Electric

Power Fluctuation Graph (Element 1) window opens.  You can also choose
View > Voltage, Current, and Electric Power Fluctuation Graph > Element1
from the toolbar.

Display Example: Voltage, Current, and Electric Power Fluctuation Graph
(Element 1)

Showing/Hiding the Graph
Use the show/hide check box to select whether to show or hide the waveform.
Selection can be made for voltage (rms), current (rms), and active power
individually.

Show/Hide check box
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Selecting the Y-Axis (Current Magnitude) Scale
• Selecting the Type of Y-Axis Scale

Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.
When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

Selecting the Time Zone
Use the scroll bar to set the time zone to be displayed.  The voltage, current,
and electric power fluctuation graph of the specified time zone is displayed.

The left end position (time) corresponds to the cursor position (time, 
see page 4-4) of the Overall Evaluation Graph.

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

4.6  Displaying the Graph of Voltage, Current, and Power
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Explanation
The fluctuation of the voltage, current, and power data over time can be displayed on
graphs.  The input element on which harmonic measurement is made varies depending
on the wiring system configuration of the WT (see chapter 8) that you are using.  The bar

graph can be displayed for each input element of the WT.

Voltage, Current, and Electric Power Fluctuation Graph Window

Scroll bar
Drag the     (slider) or click          to select the time zone you wish to 
display.  The time zone of the graph changes in sync with the slider 
position.

Select the Y-axis scale

Show/Hide check box

Selecting Show/Hide
You can select whether to show or hide the voltage (rms), current (rms), and active
power individually.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or

*0.1.
When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.
• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the

measurement range selected in the WT configuration (see chapter 8).  The
maximum value of the LOG scale is one digit above the measurement range,
and is a value that is an integer power of 10.

• If Auto range is selected in the WT configuration, the maximum value of the LIN
or LOG scale is determined based on the same principle described above using
the measurement range of the WT that was used when measurement was made

as a reference.

4.6  Displaying the Graph of Voltage, Current, and Power
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Color
The colors of the voltage (rms), current (rms), and active power graphs are as follows:

  blue: current (rms),  red: voltage (rms),  dark yellow: active power

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

Mutual Relationship between the Voltage, Current, and Electric Power Fluctuation
Graph and Overall Evaluation Graph (See Section 4.1)

The left end position (time) of the Voltage, Current, and Electric Power Fluctuation
Graph corresponds to the cursor position (time, see page 4-4) of the Overall
Evaluation Graph.  If you move the cursor on the Overall Evaluation Graph, the time

at the cursor position becomes the time at the left end of the Voltage, Current, and
Electric Power Fluctuation Graph.

4.6  Displaying the Graph of Voltage, Current, and Power
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4.7 Displaying the Bar Graph of the Harmonic
Phase Angle

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and
one input element is used.

Displaying the Bar Graph of the Harmonic Phase Angle
From the View menu, point to Harmonic Phase Angle Bar Graph then choose

Element1.  The Harmonic Phase Angle Bar Graph (Element 1) window opens.
You can also choose View > Harmonic Phase Angle Bar Graph > Element1
from the toolbar.

Display Example: Harmonic Phase Angle Value Bar Graph (Element 1)

Selecting the Instantaneous Value
On the Harmonic Phase Angle Value Bar Graph window, you can use the scroll
bar to select the instantaneous values to be displayed.

Scroll bar
Drag the     (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.
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Explanation
You can display the bar graph of the harmonic phase angle.  The phase angle is not
used to evaluate whether the limits of the applicable standard are met.

The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The bar graph
can be displayed for each input element of the WT.

Harmonic Phase Angle Value Bar Graph Window

Scroll bar
Drag the    (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Meas Time
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.32 s) when the first measured data was retrieved.

• Bar graphs of the phase angle of the harmonic current with respect to the
fundamental current for each order can be displayed.  However, the phase angle with

respect to the fundamental voltage is displayed on the bar graph for the fundamental
current.
• When the harmonic phase is leading the fundamental current, a positive phase

angle is indicated; when the harmonic phase is lagging the fundamental current, a
negative phase angle is indicated.

• When the fundamental current is leading the fundamental voltage, a negative

phase angle is indicated; when the fundamental current is lagging the fundamental
voltage, a positive phase angle is indicated.

• For a description of the items from Element to Set PF in the bar graph window, see

the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/
Voltage” (page 4-8).  However, because the phase angle does not need to be
compared and evaluated against the limit, the Judgment item is not present.

• Bar graphs of phase angle are displayed in white.

Mutual Relationship of Graphs and Lists
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/
Voltage” (page 4-12).

4.7  Displaying the Bar Graph of the Harmonic Phase Angle



4-32 IM 761922-01E

4.8 Displaying the List of the Harmonic Phase
Angle

Procedure
The input element on which harmonic measurement is made varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  Below a

procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and
one input element is used.

Displaying the List of the Harmonic Phase Angle
From the View menu, point to Harmonic Phase Angle Measure Value List
then choose Element1.  The Harmonic Phase Angle Value List (Element 1)
window opens.  You can also choose View > Harmonic Phase Angle Measure
Value List > Element1 from the toolbar.

Display Example: Harmonic Phase Angle Measure Value List (Element 1)
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Selecting the Instantaneous Value
On the Harmonic Phase Angle Measure Value List window, you can use the

scroll bar to select the instantaneous values to be displayed.

Scroll bar
Drag the     (slider) or click          to select the instantaneous value you 
wish to display.  Meas Time changes in sync with the slider position.

Explanation
A List of the harmonic phase angles can be displayed.  The phase angle is not used to

evaluate whether the limits of the applicable standard are met.

The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  The list can be
displayed for each input element of the WT.

Harmonic Phase Angle Measure Value List Window

Scroll bar
Drag the    (slider) or click          to select the instantaneous value you wish 
to display.  Meas Time changes in sync with the slider position.

Meas Time
Indicates the time when the measured data was retrieved.  This example 
indicates the time (0.32 s) when the first measured data was retrieved.

4.8  Displaying the List of the Harmonic Phase Angle
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• A list of the phase angle of the harmonic current with respect to the fundamental
current for each order can be displayed.  However, the phase angle with respect to

the fundamental voltage is displayed in the list for the fundamental current.
• When the harmonic phase is leading the fundamental current, a positive phase

angle is indicated; when the harmonic phase is lagging the fundamental current, a

negative phase angle is indicated.
• When the fundament current is leading the fundamental voltage, a negative phase

angle is indicated; when the fundamental current is lagging the fundamental

voltage, a positive phase angle is indicated.
• For a description of the items from Element to Set PF in the list window, see the

explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage”

(page 4-8).  However, because the phase angle does not need to be compared and
evaluated against the limit, the Judgment item is not present.

Mutual Relationship of Graphs and Lists
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/
Voltage” (page 4-12).

4.8  Displaying the List of the Harmonic Phase Angle
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Chapter 5 Harmonic Monitor and Waveform Monitor

5.1 Monitoring Harmonics

Procedure
The input element on which harmonic monitor is performed varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  Below a
procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and

one input element is used.

To select the Harmonic Monitor mode used to monitor the fluctuation of the
harmonics while making measurements on the WT, you must set the
communication mode to On-Line (see section 3.3).

Selecting the Harmonic Monitor Mode
1. From the Setting menu, choose Measurement Mode.  The Measurement mode

setup dialog box opens.  You can also click  on the toolbar.

2. Choose Harmonic Monitor.  The Harmonic Monitor window opens.

Display Example: Harmonic Monitor Window

Note
When you switch the measurement mode, all the data retrieved and loaded up to that point

are cleared.  It is recommended that the data retrieved using Harmonic Measurement Mode

be saved (see section 6.1) before changing the measurement mode.
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Selecting the Monitored Contents
• Selecting Bar or List

Select Graph View (bar graph) or List View (list).

• Selecting Current, Voltage, or Phase Angle
Select A (current), V (voltage), or Deg (phase angle).

• Selecting the Input Element
Select the input element to be monitored.

The input element on which harmonic monitor is performed varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.

• Selecting the Type of Y-Axis Scale
Select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification of the Y-Axis Scale
When the type of scale is LIN, select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or *0.1.
When the type of scale is LOG, select *100.0, *10.0, *1.0, or *0.1.

• Setting the Y-Axis Scale to Percentage Display
Select the Percentage Display check box.  The Y-axis scale is displayed in
percentages.  The relative harmonic content of current of each order can be

displayed on graphs with the specified fundamental current (fundamental current
specified in advance when making Class C evaluation, see section 3.6) taken to
be 100%.

Note
The Percentage Display check box becomes selectable under given conditions.  The

Percentage Display check box becomes selectable when the EUT is of Class C, and ratios

are used to evaluate the limits.

5.1  Monitoring Harmonics
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• Displaying the Limits
Select the Limit Value check box.  The limits specified in the applicable

standard are displayed using yellow bars for each order.
The operation of the limit display is selectable only when the monitored item is current.

Displays the limits using yellow bars

Starting/Stopping the Monitor Operation
• Starting the Monitor Operation

Click Start.  The monitor operation starts.

• Stopping the Monitor Operation
Click Stop.  The monitor operation stops.

5.1  Monitoring Harmonics
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Explanation
The Harmonic Monitor mode is selectable only when in On-Line mode.  Harmonic
fluctuation can be monitored on bar graphs and numerical lists while making harmonic
measurements on the WT.  This mode is used to monitor the conditions of the harmonics

and does not evaluate against the standard as in Harmonic Measurement Mode.  When
the next measured data is retrieved, the previous measured data is updated and does
not remain.

The input element on which harmonic monitor is performed varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The harmonics

can be monitored for each input element of WT.

Harmonic Monitor Window
The figure below shows a bar graph example.

Displays the limits using yellow bars

Select the Y-axis scale

Select bar graph or list
Select the voltage, current, and phase angle

Select the input element

• You can monitor the bar graph or list of the voltage, current, or phase angle for each
order.
• When monitoring the current, the limits of the applicable standard can be

displayed.  When monitoring the voltage or phase angle, the limits are not
displayed, because the voltage or phase angle does not need to be compared
against the limits.

• The concept of the phase angle reference is the same as the explanation given in
section 4.7, “Displaying the Bar Graph of the Harmonic Phase Angle” (page 4-31)

• For a description of the items from Class to Set PF in the window, see the explanation

in section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage” (page 4-8).
However, Standard, Judgment, and Element items are not present.

5.1  Monitoring Harmonics
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Displaying the Limits
Comparison and evaluation are not made against the limits in Harmonic Monitor

mode.  The limits specified by the applicable standard are displayed for reference.
Since the harmonic data monitored in the Harmonic Monitor mode is an instantaneous
value, the values (list) and yellow bars (bar graph) of the limits are 1.5 times the actual

limits.
• If the Limit Value check box is selected, the limits are displayed using values or

yellow bars for each order.

• The limits are displayed only for harmonic current.
• When limits are specified by the relative harmonic content of order 3 and 5 such as

the limits for Class C equipment with active input power less than or equal to 25 W,

bars of magnitude corresponding to the current values converted from the relative
harmonic content of order 3 and 5 with the fundamental current specified in
advance (see section 3.6) taken to be 100% are displayed.

Selecting the Y-Axis (Current Magnitude) Scale
• Type of Y-Axis Scale

You can select LIN (linear) or LOG (logarithmic).

• Selecting the Magnification
When the type of scale is LIN, you can select *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, or
*0.1.
When the scale type is LOG, you can select *100.0, *10.0, *1.0, or *0.1.

• When set to *1.0, the maximum value of the Y-axis LIN scale is the value of the
measurement range selected in the WT configuration (see chapter 8).  The
maximum value of the LOG scale is one digit above the measurement range,

and is a value that is an integer power of 10.
• If Auto range is selected in the WT configuration, the maximum value of the LIN

or LOG scale is determined based on the same principle described above using

the measurement range of the WT that was used when measurement was made
as a reference.

• Percentage Display
If you select the Percentage Display check box, the Y-axis scale, THC, and POHC
can be displayed in percentages.  The relative harmonic content of current of each

order can be displayed on bar graphs or lists with the specified fundamental current
(fundamental current specified in advance when making Class C evaluation, see
section 3.6) taken to be 100%.

• When the magnification of the Y-axis scale is *1.0, the maximum scale of Y-axis
is 100.00%.

• The Percentage Display check box becomes selectable under given conditions.

The Percentage Display check box becomes selectable when the EUT is of
Class C, and ratios are used to evaluate the limits (see section 1.3).

• The percentage display is applied only to harmonic current.

• When limits are specified by the relative harmonic content of order 3 and 5 such
as the limits for Class C equipment with active input power less than or equal to
25 W, bars corresponding to the magnitude of the values are displayed on the

bar graph or the values are displayed in the list.

5.1  Monitoring Harmonics
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Color of Bars
See the explanation in section 4.2, “Displaying the Bar Graph of Harmonic Current/

Voltage” (page 4-12).  Bright green is not available.

Color of Measured Values Displayed in the List
See the explanation in section 4.3, “List Display of Harmonic Current/Voltage” (page
4-18).  Bright green is not available.

Color of Phase Angles
Bar graphs of phase angle are displayed in white.  The values displayed in the list are
black.

5.1  Monitoring Harmonics
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5.2 Monitoring Waveforms

Procedure
The input element on which waveform monitor is performed varies depending on the

wiring system configuration of the WT (see chapter 8) that you are using.  Below a
procedure is given in which the wiring system of the WT2000 is set to single-phase two-
wire (1P2W or 1φ2W, indication on the front panel varies depending on the model) and

one input element is used.

To select the Waveform Monitor mode used to monitor the waveforms while
making measurements on the WT, you must set the communication mode to
On-Line (see section 3.3).

Selecting the Waveform Monitor Mode
1. From the Setting menu, choose Measurement Mode.  The Measurement mode

setup dialog box opens.  You can also click  on the toolbar.

2. Choose Waveform Monitor.  The Waveform Monitor window opens.

Display Example: Waveform Monitor Window

Note
When you switch the measurement mode, all the data retrieved and loaded up to that point is

cleared.  It is recommended that the data retrieved using Harmonic Measurement Mode be

saved (see section 6.1) before changing the measurement mode.
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Showing/Hiding Waveforms
Use the show/hide check box to select whether to show or hide the waveform.

The selection can be made for the voltage and current individually.

Show/Hide check box

Voltage (V1) and 
current (A1) of input 
element 1

Voltage (V2) and 
current (A2) of input 
element 2

Voltage (V3) and 
current (A3) of input 
element 3

Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
Select a value from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and*0.1.

Starting/Stopping the Monitor Operation
• Starting the Monitor Operation

Click Start.  The monitor operation starts.

• Stopping the Monitor Operation
Click Stop.  The monitor operation stops.

5.2  Monitoring Waveforms
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Explanation
The Waveform Monitor mode is selectable only when in On-Line mode.  The measured
waveform can be monitored while making harmonic measurements on the WT.  This
mode is used to monitor the conditions of the waveform and does not evaluate against

the standard as in Harmonic Measurement Mode.  When the next waveform data is
retrieved, the previous waveform data is updated and does not remain.

The input element on which waveform monitor is performed varies depending on the
wiring system configuration of the WT (see chapter 8) that you are using.  The
waveforms of relevant input elements can be monitored simultaneously.

Waveform Monitor Window

Voltage waveform

Current waveform

Select the magnification of the Y-axis scale

• Element

The number of the input element under observation.  In this example, input element 1 is

under observation.

• Range

Measurement range selected in the WT configuration (see chapter 8).

Selecting Show/Hide
You can select whether to show or hide the voltage and current individually for each
input element.

Selecting the Magnification of the Y-Axis (Voltage or Current Magnitude) Scale
• The scale type is fixed to LIN (linear).  LOG (logarithmic) scale is not supported.

• You can select the magnification from *100.0, *10.0, *5.0, *2.0, *1.0, *0.5, and *0.1.
• Waveforms are displayed with the measurement range selected in the WT Setting

(chapter 8) is taken to be the maximum value (1.0) of the Y-axis scale

Color
The colors of the voltage/current waveforms for each element are as follows.
WT2000

Element Voltage Current

Input element 1  Pink  Bright green

Input element 2  Blue  Yellow

Input element 3  Turquoise  Red

* The names of the sample colors of Microsoft Word or Excel are used for the names of the colors.

5.2  Monitoring Waveforms

WT1600
The element under evaluation changes depending on the WT wiring system setting.
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Chapter 6 Loading/Saving Data and Repeatability of Measured Data

6.1 Saving Setup Information, Measured Data, and
Waveform Data

Procedure
Note

• Setup information, measured data, or waveform data cannot be saved when the

measurement mode is set to Harmonic Monitor or Waveform Monitor or when no setup

information, measured data, or waveform data is present.

• Setup information, measured data, and waveform data cannot be saved while measurement

is in progress.

Saving Setup Information
1. From the File menu, point to Save, then choose Save Setup Information.  The

Save As dialog box opens.  You can also select Save Setup Information from
the Save icon on the toolbar.

2. After setting the Save in box, enter the name of the file you wish to save in the
File name entry box.

3. Click Save.  The setup information is saved.
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Saving Measured Data, Waveform Data, or Setup Information
When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the measured data or
waveform data can be saved.
1. From the File menu, point to Save, then choose Save Measure Data.  The

Save As dialog box opens.  You can also select Save Measure Data from the
Save icon on the toolbar.

2. After setting the Save in box, enter the name of the file you wish to save in the
File name entry box.

3. Click Save.  Measured data, waveform data, or setup information is saved.

6.1  Saving Setup Information, Measured Data, and Waveform Data
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Explanation
Saving Setup Information

Various setup information configured using the software including the measurement
mode (see section 3.5), standard and measurement environment settings (see section

3.6), measurement time (see section 3.7), display settings (chapters 4 and 5), title/
comment of reports (see section 7.2) can be saved to a file.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .cfg

• Data size: Approx. 3 KB

Saving Measured Data, Waveform Data, or Setup Information
• The harmonic measurement data or waveform data retrieved from the WT in

Harmonic Measurement mode into the PC using the software can be saved to a
file.  In this case, the harmonic measurement conditions of the WT specified using

the software and setup information described above are also saved.
• When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the measured data or

waveform data can be saved.

File Name, Extension, and Data Size
• The file name can be any legal file name as defined by the PC that you are using.
• When the save operation is executed, all the files with the extensions shown in the

following table are created using the same file name.  Even when only the

measured data or waveform data of input element 1 is present, the files with
extensions .bt1 to 4, .bw1 to 3, .inf, and .cfg are created.  However, in such case,
data corresponding to zero is saved in the .bt2 to 4 and .bw2 to 3 files.

Data Type Extension Data Size (Bytes)

Measured data of input element 1 .bt1 Approx. 240 K (when the
measurement time is 2 min. 30 s)

Measured data of input element 2 .bt2 Approx. 240 K (when the
measurement time is 2 min. 30 s)

Measured data of input element 3 .bt3 Approx. 240 K (when the
measurement time is 2 min. 30 s)

Measured data common to all input elements .bt4 Approx. 12 K (when the
measurement time is 2 min. 30 s)

Waveform data of input element 1 .bw1 Approx. 8K
Data displayed as voltage/current waveforms (see section 4.5).

Waveform data of input element 2 .bw2 Approx. 8K
Data displayed as voltage/current waveforms.

Waveform data of input element 3 .bw3 Approx. 8K
Data displayed as voltage/current waveforms.

Harmonic measurement conditions of the WT .inf Approx. 1K
For details on the measurement conditions, see chapter 8.

Setup information of specifications, .cfg Approx. 3K
evaluation, etc.

Same data as those described in “Saving Setup Information” above.

6.1  Saving Setup Information, Measured Data, and Waveform Data
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6.2 Loading Setup Information, Measured Data,
and Waveform Data

Procedure
Note

• Setup information, measured data, and waveform data cannot be loaded when the

measurement mode is set to Harmonic Monitor or Waveform Monitor.

• If an error occurs while loading the setup information, the settings are reset to their default

values.

• If an error occurs while loading setup information, measured data, or waveform data, the data

may not be loaded properly.  Check the file name and extension, and load the data again.

• Setup information, measured data, and waveform data cannot be loaded while measurement

is in progress.

Loading Setup Information
1. From the File menu, point to Load then choose Load Setup Information.  The

Open dialog box opens.  You can also select Load Setup Information from the
Load icon on the toolbar.

2. Select a file name and click Open.  The setup information of the selected file is
loaded.

Loading Measured Data, Waveform Data, and Setup Information
Measured data, waveform data, and setup information can be loaded when the
measurement mode is set to Harmonic Measurement.

1. From the File menu, point to Load, and then choose Load Measure Data.  The
Open dialog box opens.  You can also select Load Measure Data from the
Load icon on the toolbar.
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2. Select a file name and click Open.  The measured data, waveform data, or
setup information of the selected file is loaded.

Explanation
Loading Setup Information

The setup information saved in section 6.1 can be loaded.
• The extension of the loaded file is .cfg.
• The contents of the setup information are as follows:

• Measurement mode (see section 3.5).
• Standard and measurement environment settings (see section 3.6).

The measurement data retrieved from the WT or loaded from a file can be

evaluated using the loaded evaluation conditions.
• Measurement time (see section 3.7).
• Display settings (chapters 4 and 5).

• Title/Comment of Reports (see section 7.2).
Reports of measurement data retrieved from the WT or loaded from a file can be
saved or printed by attaching the loaded title or comment.  For the saving and
printing procedure, see chapter 7.

Loading Measured Data, Waveform Data, and Setup Information
• The measurement data, waveform data, and setup information saved in section 6.1

can be loaded.
• Measured data can be loaded when the measurement mode is set to Harmonic

Measurement.

• When one of the files with .bt1, .bt2, .bt3, and .bt4 extension is selected in the
Open dialog box and loaded, the data of all the files with the same file name in the
same directory is loaded.  See the following table.

Data Type Extension

WT2000 Measured data of input element 1 .bt1

Measured data of input element 2 .bt2

Measured data of input element 3 .bt3

Measured data common to all input elements .bt4

Waveform data of input element 1 .bw1

Waveform data of input element 2 .bw2

Waveform data of input element 3 .bw3

6.2  Loading Setup Information, Measured Data, and Waveform Data
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Data Type Extension

WT1600* Measured data on the left side of the acquisition data window .bt1

Measured data in the center of the acquisition data window .bt2

Measured data on the right of the acquisition data window .bt3

Measured data common to all input elements .bt4

Waveform data on the left side of the acquisition data window .bw1

Waveform data in the center of the acquisition data window .bw2

Waveform data on the right side of the acquisition data window .bw3

Harmonic measurement conditions of the WT .inf
• If the communication mode is On-Line, the harmonic measurement conditions of the loaded

file are applied to “WT Setting” (chapter 8) of the software and transmitted to the WT.  If the
transmitted harmonic measurement conditions do not match the configuration of the WT, an
error message appears.  Check the configuration of the connected WT.

• If the communication mode is Off-Line, the harmonic measurement conditions of the loaded file are
applied to “WT Setting” of the software, but not transmitted to the WT.  If the mode is switched from
Off-Line to On-Line, the harmonic measurement conditions is loaded from the WT into the software.

Setup information of specifications, evaluation, etc. .cfg
Same data as those described in “Setup Information” above.

* : For WT1600

Left side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt1
Waveform data .bw1

Center of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt2
Waveform data .bw2

Right side of the acquisition 
data window
Of the elements displayed here:
Measured Data .bt3
Waveform data .bw3

6.2  Loading Setup Information, Measured Data, and Waveform Data
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6.3 Saving Harmonic Measurement Data in CSV
Format

Procedure
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), the harmonic measurement data can be saved in

CSV format.

Note
• Harmonic measurement data cannot be saved in CSV format when the measurement mode

is set to Harmonic Monitor or Waveform Monitor or when no measured data is present.

• Harmonic measurement data cannot be saved in CSV format when measurement is in

progress.

1. From the File menu, point to Save, then choose Save Harmonic Data (CSV).
The Save As dialog box opens.  You can also select Save Harmonic Data
(CSV) from the Save icon on the toolbar.

Selecting the Data to Be Saved
2. Select Current or Voltage.

3. Select the Element (input element).
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,

input element to be saved also varies.

4. After selecting a folder in the Save in box, enter the name of the file you wish to
save in the File name box.

5. Click Save.  The harmonic measurement data is saved in CSV format.
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Explanation
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), the harmonic measurement data can be saved in
CSV format.  A file in CSV format can be opened using a spreadsheet application (such

as Microsoft Excel) on your PC.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .csv
• Data size: Approx. 190 K (when the measurement time is 2 min. 30 s)

Example When the Harmonic Measurement Data Saved in CSV Format Is Opened
Using Excel

Date/Time the
file was saved

Data being measured
Current in this example.

Input element being measured
Element 1 in this example.

Order

S
am

p
le C

o
u

n
t n

u
m

b
er

Harmonic measurement values

6.3  Saving Harmonic Measurement Data in CSV Format
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6.4 Saving Waveform Data in CSV Format

Procedure
When the measurement mode is set to Harmonic Measurement and the waveform

data has been retrieved (or loaded), the waveform data can be saved in CSV format.

Note
• Waveform data cannot be saved in CSV format when the measurement mode is set to

Harmonic Monitor or Waveform Monitor or when waveform data in Harmonic Measurement

Mode is not present.

• Waveform data cannot be saved in CSV format when measurement is in progress.

1. From the File menu, point to Save, then choose Save Wave Data (CSV).  The

Save As dialog box opens.  You can also select Save Wave Data from the Save
icon on the toolbar.

Selecting the Data to Be Saved
2. Select Current or Voltage.

3. Select the Element (input element).
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,

input element to be saved also varies.

4. After selecting a folder in the Save in box, enter the name of the file you wish to
save in the File name box.

5. Click Save.  The waveform data is saved in CSV format.
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Explanation
When the measurement mode is set to Harmonic Measurement and the waveform data
has been retrieved (or loaded), the waveform data can be saved in CSV format.  A file in
CSV format can be opened using a spreadsheet application (such as Microsoft Excel) on

your PC.
• The data that is saved is the waveform data that is retrieved immediately after the

measurement is finished with the measurement mode set to Harmonic Measurement.

• Approximately 2 periods of the waveform data are saved using 1024 data points.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .csv
• Data size: Approx. 18 KB

Example When the Waveform Data Saved in CSV Format Is Opened Using Excel

Date/Time the
file was saved

Data being measured
Current in this example.

Input element being measured
Element 1 in this example.

N
u

m
b

er o
f w

avefo
rm
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ata p

o
in

ts (u
p

 to
 1024)

W
avefo

rm
 d

ata valu
es

C
urrent in this exam

ple.

6.4  Saving Waveform Data in CSV Format
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6.5 Checking the Repeatability of the Measured
Data

Procedure
Note

You cannot check the repeatability of the waveform data while measurement is in progress.

Selecting the Files to Be Compared
1. From the File menu, choose Repeatability of Measured Data.  The-

Repeatability of Measurement Data dialog box opens.

2. Click the file to be compared or enter the name of the file to be compared in the
File name box.

3. Click Open.  The file shown in the File name text box is displayed in the list of

files to be compared.
4. Repeat steps 2 and 3 to select all the files to be compared.
5. Click Exec.  Repeatability of Measurement Data window opens.

• For multi-phase equipment, it is recommended that files of the same input element

(same phase) be selected and the data be compared.  The repeatability cannot be

evaluated correctly when using measured data of different phases.

• Even if only one file is selected, the Repeatability of Measurement Data window will

open.  In this case, no comparison is made.

Files to be compared
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Evaluating the Repeatability
6. Select Average comparison or Maximum comparison.  The result of the

comparison using the selected values is displayed on the bar graph and list.

Example of Average Comparison: The difference in all harmonics is within 5%.

Example of Maximum Comparison: The difference at order 26 exceeds 5%.
Order 26 component

6.5  Checking the Repeatability of the Measured Data
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Explanation
The maximum value and mean value in the harmonics measurement data saved to files
can be compared, and the difference in the measured data can be displayed on a bar
graph and list for each order.  This function can be used to evaluate whether the

difference between data measured under the same measurement conditions when
harmonics are measured using the same product or same product model is within 5% as
defined in the standard (confirmation of repeatability).

Repeatability of Measurement Data Window
The following figure shows an example when maximum values are compared.

Average

+5% line

–5% line–Max Error
(yellow)

+Max Error
(blue)

Red when the 5% line is exceeded

B
ar g

rap
h

 d
isp

lay
L

ist d
isp

lay
Scroll bar

• When Maximum Values Are Compared
Maximum (Mxmax)

Maximum value among the maximum values of each order

Minimum (Mxmax)

Minimum value among the maximum values of each order

Average (Mxmean)

Average of the maximum values of each order of the selected file

+Max Error

Ratio (%) of the difference between Mxmax and Mxmean of each order

Mxmax – Mxmean
Mxmean

× 100

–Max Error

Ratio (%) of the difference between Mxmin and Mxmean of each order

Mxmin – Mxmean
Mxmean

× 100

6.5  Checking the Repeatability of the Measured Data
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• When Using Average Values Are Compared
Maximum (Mnmax)

Maximum value among the average values of each order

Minimum (Mnmin)

Minimum value among the average values of each order

Average (Mnmean)

Average of the average values of each order of the selected file

+Max Error

Ratio (%) of the difference between Mnmax and Mnmean of each order

Mnmax – Mnmean
Mnmean

× 100

–Max Error

Ratio (%) of the difference between Mnmin and Mnmean of each order

Mnmin – Mnmean
Mnmean

× 100

Color
• Bar Graph

The bar graph that is displayed for each order is displayed using a length
converted from the +Max Error or –Max Error.  The meaning of the colors is

indicated in the following table.

Blue
Difference (error) less than the +5% line for +Max Error.

Yellow
Difference (error) less than the –5% line for –Max Error.

Red
Difference (error) greater than the +5% line for +Max Error.
Difference (error) greater than the –5% line for –Max Error.

* The names of the sample colors of Microsoft Word or Excel are used for the names of the
colors.

• List
The maximum, minimum, average, +maximum error, and –maximum error for each
order are displayed using values in black.

Number of Files That Can Be Compared
To evaluate the repeatability of the measured data, multiple files must be selected.
Number of files that can be compared: 2 to 10

Note
• For multi-phase equipment, it is recommended that files of the same input element (same

phase) be selected and the data be compared.  The repeatability cannot be evaluated

correctly when using measured data of different phases.

• Even if only one file is selected, the Repeatability of Measurement Data window will open.  In

this case, no comparison is made.

• To evaluate the repeatability, check that the measured data saved to the file to be compared

was measured under the following conditions.

• Same DUT (not the same model, but the same equipment).

• Same test conditions.

• Same test equipment.

• Same atmospheric conditions (when the DUT is affected by them).

6.5  Checking the Repeatability of the Measured Data
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6.6 FTP Client Function

Procedure
By connecting to the FTP client (WT1600), data that is stored in the WT's internal hard

disk or floppy disk can be saved directly on the PC.
Setup the FTP server function on the WT1600.  For details, see the WT1600 User's
Manual (IM 760101-01E).

1. Choose File > FTP Client from the menu bar.

2. The FTP Client dialog box is displayed.  Click Setting.

When connecting with the GP-IB interface.
3. Enter the IP address, user name, and password of the target WT.

When Connecting with the Ethernet Interface (WT1600 Option)
4. Proceed to step 5.

5. Click Connect.  A server connection is opened with the WT.
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6. When saving data on the PC that was saved on the WT, select the data you
wish to save and click .  When saving data on the WT that was saved on the

PC, select the data you wish to save and click .

Specifying a Save Destination for Measured Data 

To cut the server connection, click the Disconnect button.

6.6  FTP Client Function
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Chapter 7 Saving/Printing Screen Images and Reports

7.1 Saving Screen Image Data in BMP Format

Procedure
1. From the File menu, point to Save, then choose Save Display Image (BMP).

The Save As dialog box opens.  You can also select Save Display Image from
the Save icon on the toolbar.

2. After selecting a folder in the Save in box, enter the name of the file you wish to

save in the File name box.
3. Click Save.  The screen image data that is present when Save is clicked is

saved to a file in BMP format.
If you attempt to save the file using an existing file name, an overwrite warning

message appears.  In this case, the screen image data that is present when Yes is

clicked is saved to a file in BMP format.
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Explanation
The screen image data of an active window such as acquisition data, bar graph, list, and
waveform windows can be saved to a file in BMP format.

File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .bmp

• Data size: Approx. 2.5 MB maximum.  The data size varies depending on the
window being saved and the display setting of your PC.

Example When the Saved Screen Image Data Is Inserted in a Word Processor
Application (Such as Microsoft Word)

Note
You may not be able to open the BMP file saved using the software depending on the image

processing software.

7.1  Saving Screen Image Data in BMP Format
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7.2 Setting Titles/Comments of Reports and
Saving Reports in BMP Format

Procedure
Note

• Reports cannot be saved in BMP format when the measurement mode is set to Harmonic

Monitor or Waveform Monitor or when no measured data or waveform data is present.

• You cannot set the title/comment of reports or save reports to BMP format while

measurement is in progress.

Setting the Title/Comment of Reports
1. From the Setting menu, choose Report Setup.  The Report Setup dialog box

opens.  You can also choose Report Setup from the Setup icon on the toolbar.

2. Enter appropriate text in the Report Title and Report Comment text boxes.
3. Select Color or Mono for the print mode.

4. Click OK.

Saving Reports in BMP Format
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), reports can be saved in BMP format.
1. From the File menu, point to Save, then choose Save Report (BMP).  The

Save Report File dialog box opens.  You can also select Save Report from the
Save icon on the toolbar.
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• Selecting the Data for Creating the Report and Setting the Save Destination
of the Report

2. Select the Element (input element).
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,

the selectable input element to be saved also varies.

3. Select the Average, Maximum, or Wave check box to select the data for
creating the report.
• You can select multiple items.

• The Wave check box becomes selectable only for Class C equipment with active input

power less than or equal to 25 W, because the waveform data is used for evaluation

only in this case.

4. Check the save destination of the report selected in step 3.  To change the save
destination, click File on the same line.  The Save As dialog box opens.

5. After selecting a folder in the Save in box, enter the name of the file you wish to
save in the File name box.

6. Click Save.  The screen returns to the Save Report File dialog box.
7. Repeat steps 4 to 6 to set the save destination of all reports to be created.

• Executing the Save Operation
8. Click OK.

7.2  Setting Titles/Comments of Reports and Saving Reports in BMP Format
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Explanation
Reports can be created and saved to BMP format using the data measured by the
software.

Setting the Title/Comment of Reports
As necessary, you can enter a title and comment of the report that are saved along
with the report when the report is saved to BMP format.

• Number of Characters That Can Be Entered
See the table below.

Item Number of Characters That Can Be Entered

Title Up to 50 characters.

Comment Up to 50 characters.

• Print Mode
You can select whether to print the report in color or in black and white.  To print
the bar graph using different colors, it is recommended that the printing be done in

color.  For a description of the print preview and print procedure, see sections 7.4
and 7.5, respectively.

Saving the Report in BMP Format
When the measurement mode is set to Harmonic Measurement and the measurement
data has been retrieved (or loaded), reports can be saved in BMP format.

• Selecting the Data for Creating Reports
Reports can be created for each input element.  The print preview (see section 7.4)
of the report can be displayed using the software.  The saved report can also be

inserted into a word processing (such as Microsoft Word) document to be
displayed or printed (see sections 7.3 to 7.5).
• You can select average, maximum, and/or waveform data for creating the

report.
• You can select multiple items.
• The Wave check box becomes selectable only for Class C equipment with

active input power less than or equal to 25 W, because the waveform data is
used for evaluation only in this case.

* Average: Average of the individual data points (instantaneous values) within the

measurement time for each order.

Maximum: The maximum value among the individual data points (instantaneous

values) within the measurement time for each order.

• The input element on which harmonic measurement is made varies depending

on the wiring system configuration of the WT that you are using (see chapter 8).
Therefore, the selectable input element to be saved also varies.

• Saving the Report
The title/comment (see above) entered in advance can be saved along with the
report.  When saving the average, maximum, and wave reports, assign a separate

name for each report.

• File Name, Extension, and Data Size
The file name can be any legal file name as defined by the PC that you are using.
• Extension: .bmp
• Data size: Approx. 2.5 MB maximum.  The data size varies depending on the

window being saved and the display setting of your PC.

7.2  Setting Titles/Comments of Reports and Saving Reports in BMP Format
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Example When the Saved Report (Average) Is Loaded to a Word Processor
Application (Such as Microsoft Word)

For a description of the items displayed within the report, see the explanation in
section 4.2, “Displaying the Bar Graph of Harmonic Current/Voltage” (page 4-8).

Note
You may not be able to open the BMP file saved using the software depending on the image

processing software.

7.2  Setting Titles/Comments of Reports and Saving Reports in BMP Format
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7.3 Setting the Printer

Procedure
1. From the File menu, choose Print Setup.  The Print Setup dialog box opens.

2. Enter appropriate settings for Printer, Size, Source, and Orientation.

3. Click OK.

Note
Always use A4-sized paper when printing.  Depending on the printer, some portions of the

document may not be printed on the page if paper smaller than A4 is used.

Explanation
Set the printer according to the environment of the system that you are using.



7-8 IM 761922-01E

7.4 Previewing the Printout

Procedure
Note

• Print preview of reports cannot be displayed when the measurement mode is set to Harmonic

Monitor or Waveform Monitor or when no measured data or waveform data is present.

• Print preview of reports cannot be displayed when measurement is in progress.

Displaying the Print Preview of the Screen Image
1. From the File menu, point to Preview and then choose Display Image.  The

screen image that is present when Display Image is selected is previewed.
The screen image data of an active window such as acquisition data, bar graph, list,

and waveform windows is previewed.

2. You can perform various operations such as Next Page/Prev Page, One Page/
Two Page, and Zoom In/Zoom Out.  Click Print to print the image (see section

7.5).

Display Example: Print Preview Window
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Displaying the Print Preview of Reports
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,
the selectable input element to be previewed also varies.  Below a procedure is given
in which the wiring system of the WT2000 is set to single-phase two-wire (1P2W or

1φ2W, indication on the front panel varies depending on the model) and one input
element is used.

When the measurement mode is set to Harmonic Measurement and the measured
data or waveform data has been retrieved (or loaded), the print preview of the report
can be displayed.

1. Choose File > Preview > Report > Element1.  The report is previewed on the
Report Preview window.

2. You can perform various operations such as Next Page/Prev Page, One Page/
Two Page, and Zoom In/Zoom Out.  Click Print to print the image (see section

7.5).

Display Example: Print Preview Window

7.4  Previewing the Printout
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Explanation
You can preview the print image on the screen.  Perform various operations on the print
preview window according to the PC environment that you are using.

Print Preview of the Screen Image
The screen image data of an active window such as acquisition data, bar graph, list,
and waveform windows is previewed.

Print Preview of Reports
When the measurement mode is set to Harmonic Measurement and the measured

data or waveform data has been retrieved (or loaded), the report can be previewed.
• The report that uses the average and maximum data can be previewed for each

input element.
* Average: Average of the individual data points (instantaneous values) within the

measurement time for each order.

Maximum: The maximum value among the individual data points (instantaneous values)

within the measurement time for each order.

• For Class C equipment, the limit that was used is also displayed.
• For Class C equipment with an active input power less than or equal to 25 W,

waveforms as described in section 4.5 are also previewed, if waveforms are being

used for evaluation.
• The input element on which harmonic measurement is made varies depending on

the wiring system configuration of the WT that you are using (see chapter 8).

Therefore, the selectable input element to be previewed also varies.

Selecting Color/Mono for Reports
The print mode is selected in the title/comment setting of reports (see section 7.2).  If
Color is selected there, the preview is displayed in color.  If Mono is selected, the
preview is displayed in black and white.

7.4  Previewing the Printout
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7.5 Printing

Procedure
Note

• Printing of reports cannot be displayed when the measurement mode is set to Harmonic

Monitor or Waveform Monitor or when no measured data or waveform data is present.

• Reports cannot be printed when measurement is in progress.

Printing Screen Images
1. From the File menu, point to Print and then choose Display Image.  The Print

dialog box opens.  You can also choose Display Image from the Print icon on

the toolbar.

2. Set the Printer, Print range, and Copies.
3. Click OK.  The screen image that was present when Display Image was

selected in step 1 is printed.
The screen image data of an active window such as acquisition data, bar graph, list,

and waveform windows is printed.
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Print Example

7.5  Printing
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Printing Reports
The input element on which harmonic measurement is made varies depending on the

wiring system configuration of the WT that you are using (see chapter 8).  Therefore,
the selectable input element to be printed also varies.  Below a procedure is given in
which the wiring system of the WT2000 is set to single-phase two-wire (1P2W or

1φ2W, indication on the front panel varies depending on the model) and one input
element is used.

When the measurement mode is set to Harmonic Measurement Mode and the
measurement data has been acquired (or loaded), the report can be printed.
1. Choose File > Print > Report > Element1.  The Print dialog box opens.  You

can also choose Print > Report > Element1 from the toolbar.

2. Set the Printer, Print range, and Copies.

3. Click OK.  The reports that use the average and maximum data are printed on
separate pages.

7.5  Printing
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Print Example

7.5  Printing
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Explanation
Set the printer according to the environment of the system that you are using.

Printing Screen Images
The screen image data of an active window such as acquisition data, bar graph, list,
and waveform windows is printed.

Printing Reports
When the measurement mode is set to Harmonic Measurement and the measured
data has been retrieved (or loaded), the report can be printed.

• The report that uses the average and maximum data can be printed for each input
element.
* Average: Average of the individual data points (instantaneous values) within the

measurement time for each order.

Maximum: The maximum value among the individual data points (instantaneous values)

within the measurement time for each order.

• For Class C equipment, the limit that was used is also printed.

• For Class C equipment with an active input power less than or equal to 25 W,
waveforms as described in section 4.5 are also printed, if waveforms are being
used for evaluation.

• The input element on which harmonic measurement is made varies depending on
the wiring system configuration of the WT that you are using (see chapter 8).
Therefore, the selectable input element to be printed also varies.

Selecting Color/Mono for Reports
The print mode is selected in the title/comment setting of reports (see section 7.2).  If

Color is selected there, the report is printed in color.  If Mono is selected, the report is
printed in black and white.

7.5  Printing
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Chapter 8 Setting WT Measurement Conditions

8.1 Setting the Measurement Conditions of the
WT2010/WT2030

Procedure
1. Select WT2000 in the WT selection area, and when online, choose Setting >

WT Setting.   You can also choose WT Setting from the Setup icon on the

toolbar.  You can set the measurement conditions of the target WT.

2. Set the measurement conditions of the WT on the WT Setting dialog box.  When
an item is changed on the dialog box, the corresponding measurement condition
of the WT is changed.

PLL source
Select the signal source of the 
fundamental period used as a reference 
for determining the harmonic orders.

Display format
Select Value (measured value) or Cont 
(relative harmonic content)

Display format of the phase 
angle
Select 360° or 180° format.

Crest factor
Fixed to 3.

Wiring system
Select the wiring system of the 
measurement circuit.

Frequency filter
Select On or Off.

Display items
Select for each display A 
through D.

Measurement range of 
voltage/current
Set for each element.
• Select the voltage range and 

current range.
• Select scaling On or Off.
• Set the PT ratio, CT ratio, 

and scaling factor.
• Set the scaling value of the 

external shunt.

Note
• When taking measurements with this software, the antialiasing filter cutoff frequency is fixed

at 5.5 kHz.

• The exponential average of the 1.5 second time constant (when the fundamental frequency is

50/60 Hz) is calculated internally by the software.  (the exponential average function on the

WT2000/WT1600 is turned OFF).



8-2 IM 761922-01E

Explanation
The measurement conditions of the WT2010 or WT2030 can be set from the software
via the GP-IB interface.
• For a description of the setting of the conditions used when retrieving the measured

harmonic data into the PC, see chapter 3.  For a description of the procedure of
displaying the retrieved measurement data and waveform data, see chapters 4 and 5,
respectively.

• The menu used to select the input element of the target data varies depending on the
wiring system specified here when displaying or saving measured data/waveform data
or creating, saving, or printing (see chapter 7) reports.

• When an item is changed on the dialog box, the corresponding measurement
condition of the WT is changed.

• The software starts communications with the target instrument when the software is

started, the communication mode is set to On-Line mode, and the GP-IB address is
selected.  At this point, the software loads the measurement conditions of the WT and
applies the conditions to the settings shown on the WT Setting dialog box.  If

communication fails and the measurement conditions of the WT cannot be retrieved,
the settings shown on the WT Setting dialog box become factory default settings of
the WT.

For the setting details and setup procedure on the WT of the following parameters, see
the referenced sections in the WT2010 User’s Manual IM253101-01E or the WT2030

User’s Manual IM253102-01E.

Parameter Reference Section in the User’s Manual

PLL source Section 9.1

Display format Section 9.1

Display format of the phase angle Section 5.6

Wiring system Section 3.2
(Since the WT2010 is a digital power meter for single-phase circuits, only the single-phase,
two-wire system (1φ2W) is supported on the WT2010.)

Frequency filter Section 9.1

Display items Section 9.2

Measurement range of voltage/current Section 4.2

Line filter Section 4.1

Averaging Section 7.5

Note
• When set to On-Line mode, the crest factor of the WT is fixed to 3.  If Off-Line mode is

selected or the software is closed, the crest factor returns to the original setting.

• If the crest factor is changed to 6 from the front panel of the WT when in On-Line mode, the

measurement is executed using a crest factor of 6.  Errors increase if measurement is made

with the crest factor set to 6.  Do not change the crest factor to 6.

8.1  Setting the Measurement Conditions of the WT2010/WT2030
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8.2 Setting the Measurement Conditions of the
WT1600

Procedure
1. Select WT1600 in the WT selection area, and when online, choose Setting >

WT Setting.   You can also choose WT Setting from the Setup icon on the
toolbar.  You can set the measurement conditions of the target WT.

2. Set the measurement conditions of the WT on the WT Setting dialog box.  When
an item is changed on the dialog box, the corresponding measurement condition
of the WT is changed.

PLL source
Select the signal source of the 
fundamental period used as a 
reference for determining the 
harmonic orders.

Display Format
Selecting the Display Format

Measuring range for voltage and current
Set for each input element. 
• Voltage and current range selection.  
• Turn scaling ON or OFF.  
• Set the PT ratio, CT ratio, and the scaling factor.  
• Set the scaling value for the external shunt.  
• Select the current input method.  
• Select a zero cross filter of 500 Hz or OFF.  
• Copy filter to the same wiring unit. 
• Copy range to the same wiring unit. 
• Copy scaling to the same wiring unit.  

Wiring System
Select the wiring system pattern or wiring system 
for the circuit under test.  

Measured Items
Select the wiring unit for the item to undergo 
harmonic measurement.  

Display Detail Settings
Detailed settings for the selected display format.  

Note
• When the wiring system is pattern 1 (when all are 1P2W), filter, range, and scaling copy

applies to all other elements.
• In range copy, when you copy a 5A input element set to the 10 mA–50 mA current range, 50

A input elements are set to their smallest range of 1 A–50 A.
•  In range copy, when you copy a 50 A input element set to the 10 A–50 A current range, 5 A

input elements are set to their highest range starting on 5A.
• When taking measurements with this software, the antialiasing filter cutoff frequency is fixed

at 5.5 kHz.
• The exponential average of the 1.5 second time constant (when the fundamental frequency is

50/60 Hz) is calculated internally by the software.  (the exponential average function on the
WT2000/WT1600 is turned OFF).
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Display Detail Settings
• Numeric

Select the number of display 
items, or the list display  

Click to display the combo box, 
then select.  

When Single List or Dual List is 
selected, select the measurement 
functions and elements here.  

Select the Sigma List order.  

• Bar

Set the number of screen divisions.  

Set the display range for the order.  

Set the measurement function and 
element of the bar graph to be displayed.  

• Vector

Set the zoom factor. 

Turn numeric data ON or OFF.  

8.2  Setting the Measurement Conditions of the WT1600
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8.2  Setting the Measurement Conditions of the WT1600

• Trend
Set the time axis.  

Set the number of screen divisions. 

Select whether or not 
to sample trend data.  

If you select Manual, you can change the Upper and Lower settings.  

Click to display a combo box.  

• Wave
Set the graticule.

Set the number of screen divisions.
Select whether or not to display waveform labels.  

Select whether or not to interpolate the display.

Select whether or not to display scale values.  

Select the method for dividing up the waveform.  

Select all check boxes. 
Clear all check boxes.  

• Information
Display a table of WT screen settings.  
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Explanation
You can enter WT1600 measurement conditions from this software using the GP-IB or
Ethernet interface.
• For a description of the setting of the conditions used when retrieving the measured

harmonic data into the PC, see chapter 3.  For a description of the procedure of
displaying the retrieved measurement data and waveform data, see chapters 4 and 5,
respectively.

• The menu used to select the input element of the target data varies depending on the
wiring system specified here when displaying or saving measured data/waveform data
or creating, saving, or printing (see chapter 7) reports.

• When an item is changed on the dialog box, the corresponding measurement
condition of the WT is changed.

• When you start the software, set the communication mode to online, and select the

communication address, the software opens communication with the target
instrument.  At this point, the software loads the measurement conditions of the WT
and applies the conditions to the settings shown on the WT Setting dialog box.  If

communication fails and the measurement conditions of the WT cannot be retrieved,
the settings shown on the WT Setting dialog box become factory default settings of
the WT.

For the setting details and setup procedure on the WT of the following parameters, see
the referenced sections in the WT2010 User’s Manual IM253101-01E or the WT2030

User’s Manual IM253102-01E.

Parameter Reference Section in the User’s Manual

PLL source Section 7.4

Display format Section 4.1

Wiring system Section 5.1

Frequency filter Section 5.5

Display items Section 7.2

Measurement range of voltage/current Section 5.2

Line filter Section 5.5

Averaging Section 5.6

8.2  Setting the Measurement Conditions of the WT1600
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Chapter 9 Other Functions

9.1 Cascading/Tiling Graph and List Windows

Procedure
Cascading and tiling window functions are convenient for arranging the display.

Cascading Windows
From the Window menu, choose Cascade.  Windows are cascaded so that the
titles of all displayed windows can be seen.

Display Example

Tiling Windows
From the Window menu, choose Tile.  All the displayed windows are tiled so
that the windows do not overlap each other.
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Display Example

Explanation
Window functions are useful, when the measurement mode is set to Harmonic
Measurement, the measured data is retrieved (or loaded), and multiple graphs or lists
are displayed.

Cascade
• Windows are cascaded so that the title of all displayed windows can be seen.

• The active graph or list window becomes the front window after the cascade
operation.

• The cascade order varies depending on the type of displayed window.

Tile
• All the displayed windows are tiled so that the windows do not overlap each other.

• The active graph or list window becomes the active window after the tile operation.
• The arrangement order varies depending on the type of displayed window.

9.1  Cascading/Tiling Graph and List Windows
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9.2 Arranging Icons

Procedure
From the Window menu, choose Arrange Icons. All the minimized windows

(icons) are arranged at the lower left corner of the main window of the software.

Main window

Minimized windows (icons)

Explanation
This function is useful when various windows such as acquisition data, bar graph, and

list windows have been minimized (icons) and the icons have been moved (within or
outside the main window of the software).
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9.3 Using the Help Function

Explanation
1. From the Help menu, choose Help Topics.  The Help dialog box opens.  You

can also click  on the toolbar.

Finding the Topic from the Help Contents
2. Click the Contents tab.  Find the topic from the menu.

Finding the Topic by Keyword Search
2. Click the Keyword tab.  Enter or select the keyword to find the topic.

Explanation
On the PC while using the software, you can find information about the operating
procedures and terminology of the software.

From the Help Contents
You can select a topic from the contents and find information about the operating
procedure and terminology.

Keyword Search
• You can find information about operating procedures and terminology using

keywords.
• You can enter the keyword or select the keyword from a list.
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9.4 Viewing Version Information

Procedure
From the Help menu, choose About.  The Harmonic Analysis Software version

information dialog box opens.

Harmonic Analysis Software Version Dialog Box

Explanation
The name and version information of the software is displayed.
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Chapter 10 Specifications

Specifications

Item Specifications

Software* The Harmonic Analysis Software measures harmonic currents of electrical equipment according to
the IEC Standard and indicates/saves the results of evaluations made according to the standard.
The executable file name is IEC61000_3_2.exe.

Applicable measurement The WT1600 Digital Power Meter (model 760101), or three of the WT2000 series of digital power
meters (the WT2010 model 253101, or the WT2030 models 253102 and 253103) by YOKOGAWA.

Applicable standard* IEC 61000-3-2 (Electromagnetic compatibility (EMC) - Part 3-2: Limits - Limits for harmonic current
emissions (equipment input current ≤ 16 A per phase)) Edition 2.1 and EN61000-3-2 Amendment 14.

Functions Retrieving and loading of measured data/waveform data to be evaluated
• Setting of WT measurement conditions.
• Retrieving of measured data or waveform data from the WT connected online (On-Line Mode).
• Loading of measured data or waveform data already saved (Off-Line mode).

Measurement mode*
• Harmonic Measurement Mode

• When in On-Line Mode
Measures and evaluates harmonics on the measurement data retrieved from the WT
according to the method complying with IEC61000-3-2 Edition 2.1.

• When in Off-Line Mode
Evaluates the measurement data loaded from files according to the method complying
with IEC61000-3-2 Edition 2.1.

• Harmonic Monitor Mode
Monitor harmonic fluctuation on bar graphs and numerical list while making measurements on
the WT only in On-Line mode.

• Waveform Monitor Mode
Monitor waveforms while making measurements on the WT on in On-Line mode.

Standard and measurement environment
Sets the classification of the equipment under test (EUT) as defined in IEC 61000-3-2 Edition
2.1 and evaluation conditions within each class.

Measurement time
Time from measurement start to measurement stop.
Selectable range: 0 H 2 M 1 S to 24 H 0 M 0 S in units of 1 s.

Title/Comment of reports
Sets the title/comment of reports.  You can select color or black and white for reports.  Saved/
Printed along with the measured data.

Starting/Stopping of measurements
Starts measurements when in On-Line mode.

Displaying of the evaluation results and measured data/waveform data
Only when the measurement mode is set to Harmonic Measurement, displays the result of
the evaluation as whether the harmonic current data up is within the limits of IEC 61000-3-2
Edition 2.1 and the corresponding measured data.
• Display of the evaluation result within the entire measurement time

Evaluates as to whether all of the harmonic measurement data in the measurement time
are within the limits and display the results.

• Bar graph display of harmonic current/voltage
Displays bar graph of the harmonic measurement data and the standard limits for each order.

• List display of harmonic current/voltage
Displays a list of the harmonic measurement data and the standard limits for each order.

• Fluctuation graph display of harmonic current
Displays the graph of the harmonic current fluctuation over time for each order.

• Waveform display of voltage/current
Display the waveforms occurring just after stopping measurement (approximately 2 periods of the
waveform using the WT2000, or approximately 4 periods on the WT1600).    Place the cursor on
the current waveform and read the phase difference (phase angle) from the first zero-crossing
point of the voltage waveform and the current value.

• Fluctuation graph display of voltage/current/active power
Displays the graph of the fluctuation of the rms value of the voltage and current as well as the
active power that are determined from the measured fundamental signal and all harmonics.

• Bar graph display of the phase angle of the harmonic current
Displays the bar graph of the phase angle of the harmonic current with respect to the
fundamental signal for each order.

• List display of the phase angle of the harmonic current
Displays a numerical list of the phase angle of the harmonic current with respect to the
fundamental signal for each order.
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Item Specifications

Loading of setup information, measured data, and waveform data
• Saving and loading of data

Save to a file setup information including the measurement mode, standard and
measurement environment settings, measurement time, title/comment of reports.  Loading of
the setup information is also possible.

• Loading of measured data and waveform data
Save measured data or waveform data of harmonics to files.  Setup information such as the
measurement mode, standard and measurement environment settings, measurement time,
title/comment of reports and the harmonic measurement conditions of the WT specified by the
software are also saved.  Loading of the saved measured data, waveform data, harmonic
measurement conditions, and setup information is also possible.

• Saving of the measured data or waveform data in CSV format
Save the measured data or waveform data of harmonics to a file in CSV format.  The saved
data can be loaded on a PC software application supporting CSV format.

Saving/Printing of screen images and reports
Save screen images or reports to a file in BMP format.  Printing also possible.

Repeatability of measured data
Compares the harmonic measurement data that is saved to files, and displays the difference
in the measured data on a bar graph and numerical list.  Enables confirmation of whether the
difference between data measured using the same product is within 5% as defined by the
standard (confirmation of repeatability)

System requirements Hardware
• PC

PC on which Windows 98, Windows Me, Windows XP Professional, Windows NT 4.0
Workstation, or Windows 2000 Professional runs.  Celeron 500 MHz CPU or higher.

• Internal memory
128 MB or more.

• Hard disk
Free space of 10 MB or more.

• GP-IB port
A GP-IB port made by National Instruments (Version 1.60 or later) must be installed in the
PC.

• Ethernet communication port (WT1600 only)
10BASE-T/100BASE-T compatible Ethernet communications port required.

• Disk drive
One CD-ROM drive.  The drive is used to install the software.

• Display
Display compatible with Windows 98, Windows Me, Windows XP Professional, Windows NT
4.0 Workstation, or Windows 2000 Professional.  A resolution of 1024 × 768 dots or higher
Analog RGB with 65,536 colors or more recommended.

• Mouse or pointing device
Mouse or pointing device compatible with Windows 98, Windows Me, Windows XP
Professional, Windows NT 4.0 Workstation, or Windows 2000 Professional.

• Printer
Printer compatible with Windows 98, Windows Me, Windows XP Professional, Windows NT
4.0 Workstation, or Windows 2000 Professional.  Printer driver compatible with Windows 98,
Windows Me, Windows XP Professional, Windows NT 4.0 Workstation, or Windows 2000
Professional is required.  A color printer recommended.

Operating System
Windows 98, Windows Me, Windows XP Professional, Windows NT 4.0 Workstation, or
Windows 2000 Professional is required.

WT Digital Power Meter
• The WT2010 or WT2030 Digital Power Meters with firmware (ROM) version 1.41 or later and

a GP-IB interface.
• The WT1600 Digital Power Meters with firmware (ROM) version 2.07 or later, and a GP-IB or

Ethernet interface.

* Only the WT2000 supports judgment according to standards.  The WT1600 supports analysis based on standards, but
measurement accuracy is limited in some parts so measurements cannot be taken that are in full compliance with standards.

Specifications
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